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About Infoprint Designer for iSeries: Getting Started

(G544-5773)

This publication provides information about using Infoprint® Designer for iSeries™
Version 1 Release 1 (licensed program number 5733-ID1), hereafter referred to as
Infoprint Designer. In order to get some of the functions described in this manual,
you must install these PTFs:

SF67761
SF67762
SF67763
SF67764

To determine whether you have these PTFs installed, from the Infoprint Designer
window, open the Help menu and select About.... The version shown will be 1.15 if
you have these PTFs installed.

This publication helps you prepare to use IBM® Infoprint Designer for iSeries. It
includes installation instructions, and describes features of this product and includes
examples of how to use the product.

Who should read this publication

The information in this publication is directed at people who need to understand
how to use Infoprint Designer.

Conventions and terminology used in this publication

The term iSeries refers to the server previously called AS/400®. The term OS/400®
refers to the operating system of the iSeries.

Understanding syntax notation
These rules apply to coding illustrations throughout this publication:

Variable data is printed in italics. Enter specific data to replace the characters in
italics. For example, for ImageType you could enter IM1. Italics also identify the
names of publications.

Bold highlighting identifies commands, keywords, files, directories, and other
items whose names are predefined by the system, or items that must be entered
as is, such as -ink.

Monospacing, for example, gif2afp identifies examples of specific data values,
examples of text similar to what you might see displayed, examples of portions of
program code similar to what you might write as a programmer, messages from
the system, or information you should actually type.

0S/400 commands are printed in all upper case letters. They must be entered
exactly as they appear.

Prerequisite and related information

The Printing Systems iSeries Products Web page contains information about this
product. Refer to this Web page:

[ttp://www.ibm.com/printers/R5PSC.NSF/Web/as400overview|

© Copyright IBM Corp. 2001, 2003 Xi
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Refer to the README file for the latest information about your version of Infoprint
Designer. The README file is stored on your iSeries in this location:

\\system\QIBM\ProdData\AFPDesigner\read language code.txt

Use the iSeries Information Center as your starting point for looking up iSeries
technical information.

You can access the Information Center From this Web site:

[rttp://www.ibm.com/servers/eserver/iseries/infocenter|

The iSeries Information Center contains advisors and important topics such as
Java™, TCP/IP, Web serving, secured networks, logical partitions, clustering, CL
commands, and system application programming interfaces (APIs). It also includes
links to related IBM Redbooks™ and Internet links to other IBM Web sites such as
the IBM home page.

With every new hardware order, you receive the iSeries Setup and Operations
CD-ROM, SK3T-4098-02. This CD-ROM contains IBM @server iSeries Access for
Windows® and the EZ-Setup wizard. iSeries Access Family offers a powerful set of
client and server capabilities for connecting PCs to iSeries servers. The EZ-Setup
wizard automates many of the iSeries setup tasks.

For other related information, see the [‘Bibliography” on page 99|

iISeries Navigator

Xii

IBM iSeries Navigator is a powerful graphical interface for managing your iSeries
servers. iSeries Navigator functionality includes system navigation, configuration,
planning capabilities, and online help to guide you through your tasks. iSeries
Navigator makes operation and administration of the server easier and more
productive and is the only user interface to the new, advanced features of the
0OS/400 operating system. It also includes Management Central for managing
multiple servers from a central system.

You can find more information about iSeries Navigator in the iSeries Information
Center and at this Web site:

[http://www.ibm.com/eserver/iseries/navigator/|
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Summary of changes

Summary of changes for Infoprint Designer for iSeries: Getting Started,
G544-5773-03.

This publication contains additions and changes to information that was previously
presented in Infoprint Designer for iSeries: Getting Started, G544-5773-02. The
technical additions are marked with a change bar (| ) in the left margin. In order to
get some of the functions described in this manual, you must install these PTFs:

+ SF67761
+ SF67762
* SF67763
+ SF67764
To determine whether you have these PTFs installed, from the Infoprint Designer

window, open the Help menu and select About.... The version shown will be 1.15 if
you have these PTFs installed.

These changes have been made throughout the book:
» References to AS/400 have been changed to iSeries.

* References to Client Access and Client Access Express have been changed to
iSeries Access.

This information is new or updated:

* The information in “About this publication” has been moved to|‘About Infoprinﬂ
[Designer for iSeries: Getting Started (G544-5773)" on page Xi.

[‘Infoprint Designer shortcut keys” on page 16| has been added.

+ [“Saving your work” on page 26|has been updated.

[‘Creating a project based on a similar project” on page 26| has been added.
[‘Uploading your overlay to the iSeries” on page 26| has been updated.
[‘Setting layout properties” on page 33| has been added.

+ [‘Layout Editor windows” on page 35| has been added.

+ [‘Producing some common layout formats with the Layout wizard” on page 40| has
been added. It replaces the information in the section “Producing some common
layout formats” and the chapter “Using Conditional Processing”

« [*Migrating existing page definitions and form definitions” on page 64| has been
moved to [Chapter 8, “Understanding page definitions and form definitions. ]

* A glossary has been added.

© Copyright IBM Corp. 2001, 2003 Xiii
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Chapter 1. Introducing IBM Infoprint Designer for iSeries

IBM Infoprint Designer for iSeries (hereafter referred to as Infoprint Designer)
provides a fully-graphical document composition interface to the iSeries printing
system. It supports the requirements of today’s complex documents and reports,
producing fully electronic pages with data, text, electronic forms, graphics, image,
bar codes, and typographic fonts. You can use Infoprint Designer to design new
output applications or to reengineer existing applications. Infoprint Designer consists
of three integrated components:

Infoprint Overlay Editor designs overlays (also called electronic forms).
Infoprint Image Editor designs images to use in overlays or print applications.

Infoprint Layout Editor puts all the design components together into the final
document or report.

Infoprint Designer is a Windows-based system with tight integration to the iSeries.
Print files to be redesigned can be downloaded directly into the Infoprint Layout
Editor. The design functions are grouped together into projects. Each project
contains all of the resources (images, overlays, page definitions, and form
definitions) required for production. The entire interface is designed for a
non-technical user. Once the design is complete, you upload the resources to the
iSeries, where they are automatically created in the proper format. This lets you
easily put the application into production.

What can | do with Infoprint Designer?

There are several ways that you can use Infoprint Designer:

© Copyright IBM Corp. 2001, 2003

Create overlays (electronic forms): You can create overlays to use with your
current output formatted by DDS or Advanced Print Utility (APU). This lets you
migrate from pre-printed forms to electronic overlays. When you do this, DDS or
APU can still format the production output. Use Infoprint Designer to create
overlay projects that contain one or more overlays. You can use the Overlay
Editor to create an overlay in any of these ways:

— Draw the overlay with the Overlay Editor.
— Trace over an existing scanned (TIFF) image of your pre-printed form.
— Import an AFP™ overlay object from your iSeries.

If you are primarily going to use Infoprint Designer to create overlays, focus on
[Chapter 4, “Starting an Overlay Project,” on page 19

Use powerful AFP page formatting: You want to take advantage of AFP’s
powerful page formatting and you want to format your data onto your overlays
graphically. Use Infoprint Designer to seamlessly download spooled files that you
have retained from an application run. You can then display them in the Layout
Editor for drag-and-drop placement on your overlays. If you are migrating from
continuous pre-printed forms with each page identically embossed, you only need
to do minimal reformatting to fine tune the layout. With Infoprint Designer’s
graphical design capability, Infoprint Designer makes application-independent
formatting easier. You can also produce layout projects with or without overlays in
the background. For more information, see [Chapter 5, “Using the Layout Editor,’|
Use variable page-to-page formatting: You are comfortable with AFP and you
want to use more variable page-to-page formatting, such as ‘spot carbon’ and
‘multiple-up’ applications. For more advanced output, you still use the Layout
Editor, but you approach the output with a logical sequence of what goes where




and when. To make this task easier, the Layout Editor includes a design wizard
that helps you plan your layout page by page.

To create complex applications, you need to better understand the
well-architected structure of the AFP formatting objects called page definitions
and form definitions. Page definitions and form definitions let you format your
printing outside of the application code. This independence facilitates portability
in your application development platform to move toward Java or XML.

For more information about page definitions and form definitions, see |Chapter 8,|
|“Understanding page definitions and form definitions,” on page 63.| To follow an
example of a complex print application, see [‘Producing some common Iayout|
[formats with the Layout wizard” on page 40.

* Touch up or convert images: You can use Infoprint Designer’s Infoprint Image
Editor component to touch up or convert images, such as logos and signatures,
to use in your AFP output. Infoprint Image Editor lets you edit at the pel-level.
Alternatively, you can edit your existing TIFF, JPEG, GIF, BMP, ICO, or PTR files
and then convert them to AFP page segments. For information about using the
Infoprint Image Editor, see [Chapter 7, “Using the Image Editor,” on page 59

Understanding Infoprint Designer projects

Infoprint Designer uses the concept of a project to group all of the resources
required to print the output of a single application. The project file contains
references to the overlays, images, fonts, sample data, and layout files that you can
create and send to your iSeries to print application output.

When you start Infoprint Designer, it creates a default project file named
UNTITL.PRJ, which you must rename before uploading it to the iSeries.

When you have completed your design for the application output, you can upload
the entire project to the iSeries. This puts all of the resources necessary to put the
new design into production in iSeries libraries where they can be located at print
time.

Understanding file names

2

In Infoprint Designer, you work with a number of files simultaneously: the project
file, one or more overlay files, a layout file, and possibly page segment (AFP image)
files. All of the files generated by Infoprint Designer, except the project file, are used
on the iSeries. Because of this, follow the file naming rules listed in
frules” on page 3 when naming anything other than the project file.

AFP resource files by mainframe convention (such as OS/300 or z/0S®) have
resource-specific prefixes in their file names for the resource files on the host
system. By default, Infoprint Designer does not append prefixes to file names.
When you upload your work to the iSeries, Infoprint Designer can automatically
prefix the names with these standard prefixes:

Resource type Prefix
overlays 01
page segments S1
form definition F1
page definition P1

If you want these prefixes added to the file names, you can specify to use prefixes
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for each resource type by opening the Edit menu and selecting Preferences.... The
prefix options are on the iSeries page. You can only turn prefixing on or off when a
project is not open in Infoprint Designer.

Note: When you turn on prefixing for a resource type, you can only use six
characters in the file names for that resource type.

Page Printer Formatting Aid (PPFA) and Overlay Generation Language (OGL)
keywords are not allowed as the file name of an overlay or layout file, including the
keyword UNTITL, which is the name the project, overlay, and layout files are
assigned by default if you start Infoprint Designer in its default state with a new
project open. Infoprint Designer will display an error when it detects that you have
used one of these keywords in a file name or object name.

When searching for a object to open or load, Infoprint Designer assumes these file
extensions for each file type:

Table 1. Expected file extensions

Resource Type File extension
Overlay source files OGL

Overlay object files OVL

Layout file PFA

TIFF images TIF

240-pel page segments 240

300-pel page segments 300

600-pel page segments 600

Project file PRJ

| File naming rules

[ When naming any file that will be used on the iSeries; that is, any file except the

[ project file, follow these naming rules:

| * The file name cannot exceed eight characters. If you are using prefixes for a type
[ of resource, you can only specify the last six characters. For example, if you

| specify that Infoprint Designer should add the O1 prefix to overlays, you can only
[ specify a 6-character overlay name.

| » The first character must be one of these: 'A-'Z','$', '# ', '@". It cannot be a

| number. If you are using prefixes for a type of resource, their names

[ automatically start with a letter.

[ » All other characters must be in the following group: 'A'-'Z', '0-'9', '$', '#, '@", ", "'
[ * The name cannot contain spaces.

Understanding libraries and library profiles

Infoprint Designer uses the concept of libraries to let you define a series of
directories on your PC where print resources are stored. When a resource is
requested in a project, Infoprint Designer searches these directories in the order
specified. Infoprint Designer needs this search path because resources do not
retain their PC directory location inside the overlay files or layout files. For example,
if you add a page segment to an overlay, the overlay only stores its file name, not
its PC directory location. When you load that overlay, Infoprint Designer must locate

Chapter 1. Introducing IBM Infoprint Designer for iSeries 3



4

the page segment with that name on your PC. To find it, Infoprint Designer
searches the libraries you define in a file called the library profile (file extension
LBP).

The library profile consists of an entry for each type of resource Infoprint Designer
works with (fonts, page segments, TIFF images, and overlays). Each entry specifies
one or more directories on the PC that Infoprint Designer searches when it needs to
locate a resource of that type.

Two library profiles are created in the directory \Designer\userisis during the
installation of Infoprint Designer:

 DEFAULT.LBP contains the paths to AFP outline fonts. Infoprint Designer uses
this library profile by default.

* RASTER.LBP contains the paths to AFP raster (bitmap) fonts.

Both of these library profiles specify default paths as follows for the other resource
types:

Table 2. Default paths for resource types

Default directory (under
C:\Designer, the default
product installation Default PC filetype
Type of resource file directory) extension of AFP resource
240-pel overlays (object \OVL240 OVL
format)
300-pel overlays (object \OVL300 OVL
format)
600-pel overlays (object \OVL600 OVL
format)
Overlays (source format) \OGL OGL
240-pel page segments \PSEG240 240
300-pel page segments \PSEG300 300
600-pel page segments \PSEG600 600
TIFF images \TIFF TIF

If you store resources in directories other than these, you need to append those
directories to the default ones. However, the list of directories defined in the library
profile for each resource type is limited to 1024 characters. To append directories to
the defaults, from the Defaults menu, select Libraries. You can specify relative
path names in the Path field. If you do, the directory you specify is appended to the
Start in directory defined in your desktop’s shortcut to Infoprint Designer. By default,
this directory is C:\Designer\userisis.

Example:

Assume you installed Infoprint Designer in the directory D:\Infoprint with a Start in
directory of D:\Infoprint\userisis defined in the shortcut.

If you specify ..\MyResources on the Libraries dialog, Infoprint Designer searches
in D:\Infoprint\MyResources for resources.
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If you specify \MyResources on the Libraries dialog, Infoprint Designer searches in
D:\Infoprint\userisis\MyResources for resources.

To specify which library profile the active project should use, do one of these:
* From the File menu, select New project.
* From the Edit menu, select Change library profile....

Where to obtain support

Infoprint Designer for iSeries is a standard iSeries program product. Support, both
usage (“how to") and defect reporting, is provided by IBM Software Support
(Supportline). This publication provides basic installation steps and usage guidance.
Much of this information is also available in the product’s online help.

Classroom and on-site education is also available from IBM. iSeries Infoprint
Designer University (course number K2516), a 2—day classroom course, is available
at selected locations. Check the IBM Training Solutions listings on the Web at
lhttp://www-3.ibm.com/services/learning/index.html| or contact your IBM
marketing representative. IBM can also provide jumpstart training. This is a
combination of education and implementation and is done at your location. With
jumpstart services, you customize the education to your requirements and normally
use one of your first applications as the “case study” for the training.

Online help is also available in the product. To access the online help use one of
these methods:

» Select the Help menu on the Infoprint Designer window.
* Press F1 from any dialog or window.
» Select Help from any dialog.

Refer to the README file for the latest information about your version of Infoprint
Designer. The README file is stored on your iSeries in this location:

\\system\QIBM\ProdData\AFPDesigner\read_language code.txt

Chapter 1. Introducing IBM Infoprint Designer for iSeries 5
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Chapter 2. Installing Infoprint Designer

Infoprint Designer requires a two-part installation process. First, the licensed
program must be installed on the iSeries server. Then, the workstation user can
install the program from the iSeries server to their PC (client).

When you install Infoprint Designer, eight sample projects containing overlays and
layouts are automatically installed. You can open any of the sample projects and
experiment with them using the procedures described in this book. [Appendix A]
{'Infoprint Designer sample projects,” on page 79 contains a table that describes the
sample projects. IBM @server iSeries Printing VI: Delivering the output of
e-business provides detailed descriptions of how each of the sample projects was
created.

Verifying prerequisites

Before installing Infoprint Designer, you should verify that you have satisfied these
hardware and software requirements:

Client Hardware
Intel™ Pentium® 11, Intel Pentium 1II, or compatible hardware with a
minimum of 333 MHz. Depending on the display, an appropriate graphics
accelerator card that with a minimum of 8 MB of RAM.

Operating System
For the Infoprint Designer client, one of these Windows operating systems:
* Windows 95 OSR 2.0 or higher with a minimum of 32 MB of RAM

Note: A supported version of Windows (Windows 98 or higher) is
recommended.

* Windows 98 with a minimum of 32 MB of RAM

+ Windows NT® Version 4.0 SP40 or higher with a minimum of 64 MB of
RAM

* Windows 2000 with a minimum of 128 MB of RAM
* Windows XP Professional with a minimum of 128 MB of RAM

For the iSeries Server, OS/400 Version 4 Release 5 or higher.

Software

« Print Services Facility™ (PSF) for 0S/400 is required if you are going to
print your Infoprint Designer output on an AFP printer. If you are going to
print your Infoprint Designer output on a PCL printer, you do not need
PSF.

Notes:

1. Printing output formatted with form definitions and page definitions
created by Infoprint Designer on a PCL printer is not supported on
0S/400 VARS.

2. On V5R1, PCL printing of Infoprint Designer layouts requires
installation of PTF SI02688.

3. On versions higher than V5R1, PCL printing of Infoprint Designer
layouts does not require any PTFs.

4. On all versions of OS/400, overlays created by Infoprint Designer can
be printed on PCL printers.
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* AFP Font Collection for Workstations and OS/400 (program number
5648-B45). These fonts are supplied with new licenses or
version/release upgrades of PSF/400 beginning with OS/400 V4R5.

If you are using Latin 1 fonts, ensure that you have installed the CF4LA1
(raster) and CO4LAL (outline) font libraries from the AFP Font Collection.
For more information, see
http://www.printers.ibm.com/R5PSC.NSF/web/rdfont01.

* iSeries Access, including the Toolkit and iSeries Navigator, with an
iSeries connection defined (by iSeries Navigator) on the PC on which
you will run Infoprint Designer.

Note: iSeries Access Service Pack 3 (PTF SI02795) is required if you
want to display the output formatted with Infoprint Designer layout
objects in the AFP Viewer on OS/400 V5R1.

Preparing to install Infoprint Designer

Complete these steps before you install Infoprint Designer:

1. Make sure that iSeries Access is installed on the PC where you will be installing
Infoprint Designer. iSeries Access must have a connection defined to the iSeries
system on which Infoprint Designer is licensed.

2. Map a drive to your iSeries server:
a. Open Windows Explorer.
b. From the Tools menu , select Map Network Drive....

c. Specify the drive letter for Drive:. In the Path: field, specify the system
name and path. in the format \\systemname\directorypath. For example,
\\testsys\QIBM.

Note: NetServer must be running on your iSeries in order to map a drive. If
you cannot map a drive, see [‘Problems mapping a drive with|
[Windows Explorer on your iSeries” on page 76.|

3. Have your IBM license key available.

4. Make sure your ID has the proper authority. Infoprint Designer has the
authorities for the user ID used to connect Infoprint Designer to the iSeries. In
order to download sample data from spooled files on the licensed iSeries server,
that user ID must either be the owner of the file or have *SPLCTL authority.

About the Infoprint Designer license

Infoprint Designer is licensed to an iSeries system, and only one connected PC can
use Infoprint Designer at any one time. If the link between the PC and iSeries goes
down, you are warned that the link is down. Infoprint Designer then saves the
current file and closes the session. When you close an Infoprint Designer session,
another connected PC can use Infoprint Designer.

A special offering is available to permit multiple workstations to use the Infoprint
Designer license on one iSeries system. This offering is available as a
Programming Request for Price Quotation (PRPQ) 8A8100.

Installing Infoprint Designer on your iSeries

To install Infoprint Designer on your iSeries, follow these steps:
1. Insert the Infoprint Designer CD-ROM into the server’'s CD-ROM drive.
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2. On the iSeries command line, enter this command, where 123456 123456
123456 is your 18-digit license key:
ADDLICKEY PRDID (5733ID1) LICTRM(V4R5MO) FEATURE(5050)
LICKEY (123456 123456 123456) USGLMT (*NOMAX)
3. To install on an English iSeries, enter: RSTLICPGM LICPGM(57331D1)
DEV(your-cdrom-drive-name).

4. To install on a non-English iSeries, where 2924 is not the primary language,
enter: RSTLICPGM LICPGM(57331ID1) DEV(your-cdrom-drive-name) LANG = 2924

5. (Optional) Install the IPDATA sample application library that is included with
Infoprint Designer. Enter these commands:

CPYFRMSTMF FROMSTMF ('/QIBM/ProdData/AFPDesigner/IPDATA.savf')
TOMBR('/QSYS.LIB/mylib.LIB/IPDATA.file")

RSTLIB SAVLIB(IPDATA) DEV(*SAVF) SAVF(mylib/IPDATA)

The IPDATA sample application library will help you learn about Infoprint
Designer’s interaction with the iSeries. It contains the spooled files used in the
sample projects installed on your PC by default. In order to use the AFP
resources created by Infoprint Designer, changes must be made to your printer
file. The IPDATA library includes a CL program that automates these changes.
For information about using the IPDATA sample application library, see
[Appendix C, “Using the IPDATA Sample Application,” on page 85|

Installing Infoprint Designer on your PC

Follow these steps to install Infoprint Designer on your workstation:

1. Using Windows Explorer, navigate to the \QIBM\ProdData\AFPDesigner\Install
directory on the drive you mapped inof [‘Preparing to install Infoprint]
[Designer” on page 8|

2. Double-click ibminst.exe, and the Infoprint Designer installation program starts.

3. Select a directory as the target directory for the Infoprint Designer installation or
accept the default of C:\Designer. The amount of space required for the
installation depends on what AFP fonts you choose to install. If you install all
Latinl fonts (outline, 240-pel raster, and 300-pel raster), 145 MB is required for
the installation.

4. When you encounter the product selection screen, ensure that these
components are selected:
 Infoprint Designer
* Image Editor
* Font Code Pages
* At least one type of fonts (outline, 300-pel rasters, or 240-pel rasters)

5. When the installation program completes, a window is displayed with shortcuts
to the Infoprint Designer iSeries program and to the Infoprint Image Editor
program. Copy each of these shortcut icons to the desktop.

Note: On Windows 2000, you might need to refresh this window to view the
icons.

If you will use Infoprint Designer as a server application with several clients
accessing one program, you might want to further customize your Infoprint Designer
installation. You can customize the installation so that each user has different
default values for settings such as iSeries user ID and library.
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Note: This customization is only required if the Infoprint Designer code resides only
on the iSeries. For example, in a “thin client” or Windows application server
installation, where the end user’s workstation does not have its own copy of
the program installed.

To accomplish this, follow these steps:

1. Make the equivalent of a \userisis directory for each user on your Windows
server. Create a uniquely named directory for each user under the Infoprint
Designer root directory, typically C:\Designer. For example, C:\Designer\userl.

2. Copy the contents of the userisis directory into each user’s directory.

3. On each user’'s PC, change the properties of the shortcut created for Infoprint
Designer. Specify the user’s 'userisis' directory (userl in our example) as the
Start in directory.

4. If the users also need separate access to the Infoprint Image Editor, repeat
steps and for the Image Editor.
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Updating the Infoprint Designer programs

Follow these steps to update Infoprint Designer with a program temporary fix (PTF):

1.

Install the PTF on your iSeries system using the LODPTF and APYPTF commands
for each available PTF.

Using Windows Explorer, navigate to the \QIBM\ProdData\AFPDesigner\Install
directory on the drive you mapped inin |“Preparing to install Infoprint|
[Designer” on page 8|
Double-click ibminst.exe to start the Infoprint Designer installation program.
On the fourth dialog in the installation program, select Update existing
Designer product and proceed with the installation.

Note: Updating Infoprint Designer does not overwrite work stored in the
Infoprint Designer directories.
To restore your default preferences after the installation completes, follow these
steps:
a. Use Windows Explorer to browse the backup directory you specified in the
installation process. The default directory is userisis.bak.

b. Copy the contents of that directory to the C:\Designer\userisis directory (or
the directory in which you installed Infoprint Designer), replacing the files
with the same name that the installation program just wrote.

Uninstalling Infoprint Designer and Image Editor from your PC

To uninstall Infoprint Designer and Image Editor from you PC, delete the Windows
directory where you installed them, for example, C:\Designer.
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Chapter 3. Starting Infoprint Designer

To start using Infoprint Designer, follow these steps:
1. Start the program by doing one of these:

2.

T

* Double-click the product icon on your desktop: =
* From the Windows Start menu, select Programs then IBM Infoprint
Designer.

If you do not have an active connection to the first iSeries in your iSeries
Access connection list, the Connect to iSeries dialog opens.

» Select the iSeries host that is licensed for use with Infoprint Designer and
enter your user ID and password on that system. If you select Save User ID
and Password, Infoprint Designer saves these values.

Note: If you select Save User ID and Password and your iSeries password
changes, the program will start in demo mode. To change the
password that Infoprint Designer uses to log you on to the iSeries,
follow the instructions in [‘Program starts in demo mode” on page 75.|

» If you click Cancel or cannot connect to the iSeries, Infoprint Designer
displays a message and starts in demo mode. In demo mode, you cannot
save your work or open overlay and layout files that Infoprint Designer
created. If this happens in error, close the program and start it again when
you can connect with the licensed iSeries system.

Note: The FTP server must be started on your iSeries system before you
can start Infoprint Designer.

Specify the name of an iSeries library where you will send your completed work.
This library is also used for temporary storage when spooled files are
downloaded.

To specify this library, follow these steps:
a. From the Edit menu, select Preferences....
b. Select the iSeries page.

c. Select a library from the list of available libraries on the iSeries system you
are using.

Specify the resolution of the AFP printer you will use to print the iSeries
application output. Overlays, page segments (AFP images), and raster fonts are
resolution-dependent. Also, the overlay or layout’s resolution determines which
fonts are available for you to select.

Outline fonts and TIFF images are resolution-independent. For example, when
you use a TIFF image in an overlay, it is scaled to match the overlay’s
resolution. The default resolution is 300 dpi.

To specify the AFP printer resolution you want overlays created with, follow
these steps:

a. From the Edit menu, select Preferences....
b. Select the General page.
c. Select the resolution in the Host printer resolution field.

Note: When you make proof prints on a PC-attached printer, the screen
representation of the overlay is converted to the printer’s resolution.
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5. (Optional) Set the units of measurement to use for the overlays and layouts you
create with Infoprint Designer. When you create the overlay or layout parts,
such as lines, you can specify a length and other measurement characteristics.
You can also make a ruler in the specified unit. The default is inches. To change
the default setting, follow these steps:

a. From the Edit menu, select Preferences....
b. Select the Units and grid page.
c. In the Default units field, select millimeters or pels.

You can always use different units for specific elements. For example, you can
use inches as the default units but specify the placement of a box on an overlay
in pels for greater precision.

Getting to Know the Infoprint Designer Window

When you start Infoprint Designer, a window like the one shown in
appears.

i% Infoprint Designer - Overlay editor - UNTITL.Prj (300 ppi) - 10| x|
File Edit WYiew Text Tool Defaults ‘Window Help

, 2 Pel 3][solid - 0% 3
! ~l El

E\'IEW Edit

—KFZlolo A M a2 4@ 8
Sjﬁa_ysut [URTITL [Wew overlay

0.5 1 1.5
! . . . . ! . <‘> . . ! . . . . ! . .
0H m-——— " — " — -t e e e e

Figure 1. Infoprint Designer window

The Infoprint Designer window has these parts, labeled in the diagram above:

1. The title bar shows the design mode (Overlay editor or Layout editor), the name
of the active file, and the current print resolution.
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Toolbars

The Settings area can also be considered a toolbar. If you change the settings
in this area of the toolbar, you set default values for objects before you create
them. If you change the settings when an object is selected, you change the
values for only that object. If you enter values into these fields, press Enter for
the new values to take effect. On the left side of the toolbar, Infoprint Designer
shows current settings for line thickness, type, shading, and font. You can
change those settings in that area. On the right side of the toolbar, Infoprint
Designer displays positioning information. Depending on your actions, it might
show the pointer’s location on the View/Edit window or the coordinates of a
selected object.

The subwindow labeled View/Edit is your work space for designing the
appearance of your application output.

The Action toolbar on the View/Edit window contains icons for frequently used
functions. These functions can also be accessed from the Tool menu. The
contents of the Action toolbar change depending on what mode you are in.

The Mode toolbar on the View/Edit window contains buttons that let you switch
between overlay and layout design mode. The contents of the mode toolbar
stay the same across design modes. A white background on the mode’s button
indicates the active mode. In|Figure 1 on page 14} UNTITL is the active overlay.

The broken red line in the View/Edit window in overlay design mode
corresponds to the size of the overlay you are working on. In layout design
mode, the broken red line indicates the boundaries of the logical page. This is
where data is formatted before it is placed on the physical page.

The contents of the toolbar on the View/Edit window change, depending on the
mode in which you are working. shows the action toolbar when you are in
overlay design mode.

[Figure 3 on page 16|shows the action toolbar when you are in layout mode.

O
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Select Box

Line

Circle

Path Bar Repeat Zoom Copy Align
Code Out

Text Group Zoom In Cut Paste Undo

Figure 2. Action toolbar in overlay mode
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Printline Fields Out

Figure 3. Action toolbar in layout mode

| Infoprint Designer shortcut keys

| You can access many Infoprint Designer menus and functions through keystroke
| combinations instead of using the mouse. These are the shortcuts included with
| Infoprint Designer:

| menu or function keystroke combination
| File menu ALT+F

| New Project CTRL+N
| Open Project CTRL+O
| Save Project CTRL+S
| Exit F3

| Edit menu ALT+E

| Undo CTRL+Z
| Redo CTRL+Y
| Cut CTRL+X
| Copy CTRL+C
| Paste CTRL+V
| Delete DEL

| Object properties CTRL+E
| View menu ALT+V

| Zoom 1:2 ALT+Z

| Zoomn: 1 ALT+n, n = 1-9
| Zoom 10 :1 ALT+0

| Grid CTRL+G
| Tool menu in Overlay Design mode ALT+T

| Select ESC

| Line CTRL+R
| Path CTRL+P
| Box CTRL+B
| Circle CTRL+L
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menu or function

keystroke combination

Text

CTRL+T

Tool menu in Overlay Design mode

Move selected object

CTRL+appropriate arrow

Copy selected object and position at
drop point

CTRL+Left mouse click and drag

Tool menu in Layout Design mode

Move selected field

CTRL+appropriate arrow

Move printline of selected field

SHIFT+appropriate arrow

Adjust line spacing of all fields in a
repeated printline

CTRL+Left mouse click and drag on any field

except the first field

Chapter 3. Starting Infoprint Designer
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Chapter 4. Starting an Overlay Project

When you start Infoprint Designer, it automatically opens in overlay design mode.
You can begin creating an overlay right away or you can start by naming the project
and the overlay. To start by naming the project, open the File menu and select New
project... If you always want to start Infoprint Designer this way, open the Edit
menu and select Preferences. On the View page, deselect Start with default
project. If you do this, you cannot start creating an overlay until you name the
project.

You are now ready to begin creating the overlay elements: lines, boxes, circles,
text, bar codes, and paths (polylines). If you have a scanner and a pre-printed form
that you are converting to an electronic overlay, see [‘Designing overlays to replace|
reprinted forms.”| If you have AFP overlays created with another application, see
‘Migrating existing overlays."l

Designing overlays to replace preprinted forms

For optimal results, follow these steps to create an overlay to replace a preprinted
form:

1. Scan one side of the form to create a TIFF image file. Set up your scanning
program with these options:
e TIFF format
» Bi-level (black and white)
* Resolution to match that of your target printer (probably 300 dpi, but possibly
240 or 600 dpi)
* Scan the image at actual size (1:1)

2. Start Infoprint Designer.
3. From the File menu, select Get Template.... The Get Template dialog opens.

4. Browse to the file containing the scanned form and select it. A read-only version
of the form is displayed in the View/Edit window.

5. Trace over the existing elements (boxes, lines, or text) to create an AFP overlay
that matches your current pre-printed form. You can also enhance the existing
form by adding new elements.

Migrating existing overlays

If you have an overlay in AFP object format on your PC, you can import it into
Infoprint Designer for editing. To open the overlay, select New overlay in the Mode
toolbar. You are asked to save the overlay again, this time into Infoprint Designer’s
overlay source format.

Be aware of these when importing overlay objects:

» Text objects in the overlay are not defined as text blocks, but as groups of
words, possibly only single words. This is unavoidable because of the way the
text is stored in the AFP format of the overlay.

» The orientation information in the overlay might not be preserved. For example, a
landscape overlay might import as portrait. If this happens, see the information in
[‘Landscape overlay rotates to portrait when starting Layout Editor” on page 77

 If the overlay was created using the AFP Windows driver, the text might be lost.
If this happens, create the text objects again. The text is not lost if the driver
uses a font character set - code page pair that is built into one of the fonts
supplied with or defined to Infoprint Designer.
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» If you created the overlay using the AFP Windows driver with Print Text as
Graphics specified, the overlay is scaled to 240 dpi when it is imported into
Infoprint Designer. This might change the overlay’s size.

» If the overlay was created using AFP Utilities (AFPU), font references are not
resolved correctly unless the AFPU source names AFP coded fonts. If you
receive errors about missing fonts when you open such an overlay, there are two
possible solutions:

— Re-create the text objects in Infoprint Designer.
— Change your AFPU source to reference coded fonts and re-compile the
overlay.

Note: Sometimes the font errors reported when opening an AFPU-created
overlay prevent Infoprint Designer from displaying lines and boxes on the
overlay.

Creating overlay objects

20

There are two ways to select the drawing tool you want to use:

* Use the icons on the Action toolbar on the View/Edit window. The toolbar is
shown in [Figure 2 on page 15
* Use options in the Tool menu.

Select a tool and then position your pointer inside the View/Edit window. Follow the
steps below to create each object.

To create a line:
1. Select the line tool.

2. Click where you want the line to start and drag to where you want the line to
end.

3. Draw another line or click on the line you just drew to edit it.

To create a box:
1. Select the box tool.

2. Click where you want one corner of the box to be and drag to where you want
the opposite corner of the box to be.

3. Draw another box or click on the border of the box you just drew to edit it.

To create a circle:
1. Select the circle tool.

2. Click where you want the center of the circle to be and drag outward until the
circle is the desired size.

3. Draw another circle or click on the border of the circle you just drew to edit it.

To create a path (polyline):
1. Select the path tool.

2. Click where you want the first point in the path to be, then click where you want
each additional point to be.

3. To end the path, right-click anywhere in the View/Edit window, press ESC, or
select the Select mode icon from the Action toolbar.

4. To connect the first point in the path with the last point, select the path and then
right-click. The Path attributes dialog opens.

5. On the Connection page, select Close path.
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To create formatted text:

1.
2.

Select the text tool.

Draw a box to indicate the area within which the text is formatted. This area is
the guide for centering, word wrapping, and justification.

If you have not set a default font, the Select Font dialog appears. Use this
dialog to specify the attributes of the AFP font you want to use.

If you set a default font, but want to use a different font for the text you are
creating, select the Select font icon in the Infoprint Designer toolbar in the

Settings area: . The Settings area changes when you add text with a
default font selected.

To create unformatted text:

1.
2.
3.

Select the text tool.
Click where you want the baseline of the text to be.

If you have not set a default font, the Select Font dialog appears. Use this
dialog to specify the attributes of the AFP font you want to use.

If you set a default font, but want to use a different font for the text you are
creating, select the Select font icon from the Infoprint Designer toolbar in the

Settings area: . The Settings area changes when you add text with a
default font selected.

A bar code definition is a template for a bar code. You use these templates to
create bar codes in your document. To create a bar code definition:

1.

4.

Select the bar code tool. If you do not have any bar code definitions, the Bar
code type definition dialog opens. If you do have a bar code definition, the

Bar code field properties dialog opens. To create a new bar code definition,
select New.

To create a bar code object, enter a name for the bar code definition and select
the type of encoding you want to use. Optionally specify the other options, such
as bar code size and color, and font for HRI. Select OK.

The Bar code field properties dialog opens. Select the String page and enter
the string you want printed as a bar code. Select OK.

The bar code is shown in the View/Edit window.

To create a bar code based on an existing bar code definition:

1.

2.

Select the bar code tool. The Bar code field properties dialog opens. Select
the String page and enter the string you want printed as a bar code. Select OK.

The bar code is shown in the View/Edit window.

Editing overlay objects

Follow these steps to move, resize, or change the attributes of an overlay object.

1.

Make sure the Overlay Editor is in select mode. There are two ways to specify
select mode:

¢ In the Action toolbar, select the Select mode icon.
¢ From the Tool menu, select Select.

Click on a colored pel in the object (not inside the white space of a closed
object such as a box or circle). A thin blue bounding box indicates that the
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object is selected. If you click on a point that is shared by more than one object,
a menu opens that lists the objects you can select from. Use that menu to
select the object.

Edit the object in one of these ways:

* To move the object, select it and drag it to the desired location.

* To resize the object, select one of the handles (squares on the border) of the
blue box and drag until the object is the correct size.

» To edit the attributes of the object, right-click the object. Alternatively, from the
Edit menu, select Object properties to display a dialog containing all of the
selected object’s properties.

» To edit the contents of a text object, select it and then position the cursor
where you want to change text. To change the font before inserting text,
select the font icon in the toolbar to display the Select Font dialog.

* To change the font of existing text, select the text and then select the Select

font icon from the Infoprint Designer toolbar in the Settings area:

Working with multiple objects

To select more than one overlay object, in the View/Edit window follow one of the
below procedures.

With multiple objects selected, if you press Shift or Ctrl and right-click, a menu
opens that lets you edit their common attributes. The menu lists the common
attributes that you can edit, such as LINE for the attributes of the line thickness and
style.

Select multiple objects individually

1.
2.

Press and hold Shift or Ctrl.
Select all the objects you want selected, one at a time.

Select multiple objects simultaneously

Select objects simultaneously by drawing a rectangle enclosing all objects (boxes,
texts, paths, and so forth) to be selected, as follows:

1.

Move the pointer to the desired position at one corner of the enclosing
rectangle.

Click and hold the right mouse button.
The pointer changes into a double headed arrow cursor.

Drag the arrow cursor to the desired position on the opposite corner of the
enclosing rectangle.

Release the mouse button.
All objects within the rectangle are selected.

Using design assistants: groups and repeat

22

A common requirement when designing forms is to keep several objects grouped,
so that you can easily work with all of the objects at once. To group objects
together follow these steps:

1. Select multiple overlay objects using one of the methods described in

2.

|with multiple objects.”| Images, bar codes, and other groups are not allowed in a

group.
Group the selected objects using one of these methods:
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3.

» Select the Group icon on the Action toolbar.
* From the Edit menu, select Group...

You can then move or edit the group or place a copy of the group elsewhere on
the overlay.

A group is treated as an overlay in Infoprint Designer. To make changes to the
group, follow these steps:

1.
2.

Right-click the group in the View/Edit window and select Edit group.

The contents of the View/Edit window change to only show the group as if it
were a separate overlay. You can now make any changes to the group that you
can make to an overlay. You can create new objects, move existing objects, or
edit existing objects. The changes you make are applied to all instances of the
group you have placed on the overlay.

When you are finished editing the group, select the Group icon (now labeled
Close group) on the Action toolbar.

To change a group of objects into separate objects, follow these steps:

1.
2.

Select the group in the View/Edit window.
Select the Group icon (now labeled Ungroup) from the Action toolbar.

Important: You cannot undo the ungroup action.

Forms such as invoices often contain table-like presentations of order details. To
create a section of an overlay containing multiple connected boxes where the detalil
information will be placed, use Infoprint Designer’'s Repeat function. To use the
Repeat function, follow these steps:

1. Create one object (for example, a box) and set all of its attributes the way you
want all of the objects to look.
2. Select the object you just created and specify Repeat in one of these ways:
* Select the Repeat icon from the Action toolbar.
* From the Edit menu, select Repeat....
3. The object’s Properties dialog opens. Select the Repeat page and choose one
of these options:
Repeat automatically
Duplicates the object either horizontally or vertically the number of times
that you specify. When you select OK on the properties dialog, the
object copies are added to the overlay.
To change the spacing between copies, select any copy (not the original
object) and drag it. Alternatively, select any member of the repeat group
and enter a spacing value in the S parameter in the Settings area of the
Infoprint Designer window. Press Enter to apply the changed spacing
value.
Repeat manually
Lets you place copies of the object anywhere on the overlay. When you
select Place on the properties dialog, the pointer changes to the object
you are repeating. Click anywhere on the overlay to place a copy. To
get out of the mode of placing copies, press Esc or right-click.
Notes:

1. After you create a repeat group, any attribute changes you make to any object

in the group are applied to all members of the group.
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2. To delete the copies of the original object, right-click any of the member objects
and select the Repeat page of the properties dialog. Select No repeats exist.
The copies are removed from the overlay; the original object remains.

3. There is no function to ungroup the repeated objects without deleting them.

Adding an image to an overlay

24

If the image you want to include in your overlay is in TIFF or AFP page segment

format, follow these steps:

1. From the File menu, select Get image.... The Get image dialog opens.

2. On the Get image dialog, select the image you want to add and select Open.

3. If the image you select is in TIFF format, Infoprint Designer converts the TIFF
image to an AFP page segment. A dialog opens that requires you to hame the
page segment file and specify where to store it.

4. After naming the page segment file, a dialog opens that requires you to specify
the image type to use.

5. The page segment is displayed in the top left corner of the overlay. Select the
page segment and drag it to the position where you want it.

The page segment file is the one that is uploaded to the iSeries when you upload
the whole project to the iSeries.

Note: If you have images in JPEG, GIF, or BMP formats, you can use the Infoprint
Image Editor to convert them to AFP page segments. For more information,
see [Chapter 7, “Using the Image Editor,” on page 59.|

If the image you select in step is in a directory that is not defined in your library
profile as a path for page segments, a warning message is displayed. Do one of
these:

* Copy the page segment to a directory named in the library profile for page
segments. This is the default option.

* Add the path to the library profile. The list of directories defined in the library
profile for each resource type is limited to 1024 characters. Therefore, you might
not be able to do this, depending on the length of the page segment entry in the
library profile.

If you open an overlay that includes a page segment, but the page segment is not

found in any of the directories in the library profile, an error message displays. The
missing page segment is shown in the View/Edit window as a red dashed-line box
with the words Not found in it. To display the page segment on the overlay, do one
of these:

» Copy the page segment to a directory nhamed in the library profile for page
segments. This is the default option.

* Add the path to the library profile. The list of directories defined in the library
profile for each resource type is limited to 1024 characters. Therefore, you might
not be able to do this, depending on the length of the page segment entry in the
library profile.

Select the red box, then select Refresh to display the page segment. For
information about library profiles, see [‘Understanding libraries and library profiles’1
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Tips and hints for the Overlay Editor

Use the grid

This section contains useful tips and hints when using the Overlay Editor. You will
also find the information in ['Infoprint Designer shortcut keys” on page 16 useful.

You can create very accurate overlays with the assistance of the grid feature. Open
the Edit menu and select Preferences.... Select the Units and Grid page to
specify the grid dimensions and characteristics.

To display the grid, from the View menu, select Grid. To enable grid snapping, from
the View menu, select Snap to Grid. When grid snapping is on, your overlay or
page elements are automatically aligned to the grid. For example, if you draw a box
beginning at 0.48 inches across the page and grid snapping is on with a grid at 0.5
inch increments, the box is left-aligned at 0.5 inches. We recommend that you keep
grid snapping on and only switch it off occasionally for fine adjustment of individual
objects.

Use the right mouse button

Use the right mouse button frequently. For example, if you right-click in the
View/Edit window with no objects selected, you can do these:

e zoom in or out

« fit your view to the page width or height

 refresh the data

If you have an object selected and right-click, you open the properties dialog for
that object type. This lets you edit the object’s attributes. In the Overlay Editor,

drawing a rectangle with the right mouse button selects all of the objects inside the
rectangle.

Use the Ctrl key

The Ctrl key can often be used in combination with the mouse or arrow keys to

perform additional functions that are not otherwise available. In the Overlay Editor,

try these combinations:

» With an object selected, press Ctrl in combination with one of the arrow keys to
move the object one unit in the direction of the arrow key.

* With an object selected, press Ctrl and hold the left mouse button down to copy
the object. Blue lines appear that show you where the copy will be placed.

Use the Esc key

If you have trouble deselecting an object in the View/Edit window or exiting a text
or drawing mode, select the View/Edit window and press Esc. You might need to
press Esc more than once to achieve the desired result.

Proof-printing your overlay

You can proof print your overlay on any parallel- or network-attached printer that
has been defined on your computer. The printer does not have to support AFP
printing. Infoprint Designer uses the printer driver you already installed to create a
PCL or PostScript version of the overlay. To send a proof print job, from the File
menu, select Print and then select your printer. In some cases, the printable
position of the PCL or PostScript printer might cause errors in printing. If needed,
open the Defaults menu and select Print position to adjust the print margins, so
that the overlay prints without errors.
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The proof print function for PC printers prints the complete contents of the
View/Edit window. If multiple overlays or an overlay plus layout data are shown in
the View/Edit window, they are printed as part of the proof print. To prevent this,
from the Window menu, deselect Merge windows. When Merge windows is
disabled, only the active overlay or layout is printed.

Saving your work

When you want to save your overlay, select Save project from the File menu. By
default, the overlay has the same name (but a different extension) as the name of
the project file. You can enter a new name for either the project file or the overlay

file.

Notes:

1.

Infoprint Designer automatically saves your work every 2 minutes by default. To
change the automatic save interval or to disable the automatic save function,
from the Edit menu, select Preferences. Select the General page and change
any values you want.

The overlay source files that you create with Infoprint Designer cannot be used
with other programs.

| Creating a project based on a similar project

If you want to use an overlay from one project as a basis for an overlay in a new
project, follow these steps:

1.

2.
3.
4

Open the project you want to use as a starting point for the new project.
From the File menu, select Save project as.
In the Project name field, specify the new project name.

In the Overlay file(s) list, select the overlay you want to modify for the new
project and select Save as.

On the Select overlay file dialog, specify the name of the new overlay and
select Save.

Select OK on the Save project as dialog.

Uploading your overlay to the iSeries
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When you are ready to try out your overlay on your iSeries, follow these steps:

1.

(Optional) Add a comment that displays in the Text field of the iSeries’s Work
with objects screen. This helps you identify the overlay. To add a comment,
follow these steps:

a. From the File menu, select Overlay setup.
b. Select the Name page and enter the comment in the Comment area.
From the File menu, select Upload to iSeries.... The Upload dialog opens.

On the iSeries page, change the destination library if you do not want to use
the default library. The default library is set on the Preferences dialog, which
you access from the Edit menu when you select Preferences....

Note: Each time you upload an overlay to the iSeries, it replaces any file with the

same name in the destination library.
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Printing your overlay on the iSeries

Normally, overlays that you design with the Infoprint Designer are printed with
application data that you format with the Layout Editor. However, if you want to print
the overlay you uploaded to the iSeries without going through the layout process,
there are several options. Those options include:

* Add the overlay to the existing printer file using either Override printer file
(OVRPRTF) or Change printer file (CHGPRTF) iSeries commands as follows:
xxXPRTF FILE(printer_file_name) FRONTOVL (library/front_overlay _name

offset_down offset_across) BACKOVL (library/back _overlay name offset_down
offset_across type_of overlay) DEVTYPE(*AFPDS)

Note: The OVRPRTF command temporarily changes the printer file (only for one
job); and the CHGPRTF command permanently changes the printer file for
all future jobs.

* If you have AFP Utilities (AFPU) for iSeries (5722-AF1) installed, the “Work with

Overlays” function lets you print an overlay proof.

Note: Because the AFPU print function uses the form definition named in the
printer's device description, the overlay might be shifted on the printed

page.
» Use the DDS OVERLAY keyword to place an overlay on the page.

* Print application products such as APU, Page Printer Formatting Aid (PPFA), AFP
Toolbox, and many others let you select and print overlays within a print job.

Using multiple

overlays in a project

You might want to use more than one overlay for a project. For example, you might
have one overlay that contains the company logo and is always at the top of your
company’s forms. But different overlays are used in the “body” of the different forms
depending on the form’s content. You can define the overlay with the logo once and
then include it in several projects and then define unique overlays in separate
projects.

To add an overlay to an existing project, select the New overlay icon from the
Mode toolbar. Infoprint Designer displays the Open dialog. You can select an
existing overlay or name a new one to create. When you select OK on the Open
dialog, the overlay you select becomes the active overlay in Infoprint Designer and
is automatically added to the project. To return to another overlay in the project,
select its name from the Mode toolbar.
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Chapter 5. Using the Layout Editor

The Layout Editor is the tool within Infoprint Designer that you use to map
application data from an iSeries spooled file to the printed page. Infoprint Designer
can work with either unformatted or formatted data. Unformatted data is sometimes
known as a “flat file” or SCS data. Formatted data might have some or all of the
data placement already determined, for example a customer name and address at
top left, an invoice total at bottom right. In either case, you can use Infoprint
Designer to create a layout project that lets you redesign the page layout without
changing the original application.

To begin working with the Layout Editor, do one of these:
* On the Mode toolbar in the View/Edit window, select Layout.
* From the Window menu, select Layout.

To begin mapping data without an overlay in the background, follow these steps:
1. From the File menu select New project....

2. In the New project dialog, select Layout Definition.

When you start the Layout Editor, you select your sample data. For information

about selecting sample data, see [‘'Selecting sample data from the iSeries”| or
|"Se|ecting sample data from the PC” on page 31/

Selecting sample data from the iSeries

Follow these steps to select sample data from the iSeries:

1. Specify that the spooled file stays on the output queue after printing. Using the
iSeries command interface, you can accomplish this in two ways:

» Before the application has run, enter: OVRPRTF FILE(filename) SAVE(*YES).
« After the application has run and the spooled file is on the output queue:
a. Use either WRKSPLF or WRKOUTQ to display a list of spooled files.

b. Specify Option 2, Change by the spooled file to display the Change
Spooled File Attributes screen.

c. Change the Save parameter to *YES and press Enter.

2. When you select iSeries as the source of your data file, Infoprint Designer
displays the Select an output queue dialog, as shown in[Figure 4 on page 30|
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| Figure 4. Select an output queue dialog
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3.

4.

Enter the name of the output queue containing your sample data spooled file or
select it from the list. Select OK.

The Select spooled file dialog displays, as shown in [Figure 5 on page 31} This
dialog lists all of the SCS and line data spooled files on the output queue that
are available for use with Infoprint Designer. Select the one you want to use to
create this layout.

Optionally, you can specify the number of pages of a spooled file to download to
the PC. IBM does not guarantee that you will receive exactly the number of
pages you specify, but at least that number of pages are retrieved (and possibly
up to ten pages more). If you choose to download less than the complete file,
select enough pages to ensure that you have at least one page of data for each
type of page layout you want to create for this application.

For example, if you are creating the layout for an invoice application where most
customers have only one page of output, but others have two or more pages
and you want all pages after the first to be formatted differently than the
one-page statements, make sure the data you download includes at least one
example of a multiple-page statement.

Note: Only spooled files created with a Printer device type of *SCS or *LINE
are eligible to be brought into Infoprint Designer for mapping. The Printer
device type attribute is set in the printer file.
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Figure 5. Selection of a spooled file containing sample data

5. Name the file on the PC where the downloaded spooled file should be stored.

This file name is stored in the project file so that whenever you work with this
layout project, the iSeries data is read from the PC instead of downloading it
again.

6. When you supply a name for the PC data file, the download begins. Continue to

[‘Setting layout properties” on page 33.|

Selecting sample data from the PC

If you select the PC as the source of your sample data file, follow these steps:

1. Infoprint Designer displays the Get sample data dialog. Browse to the file you

want to use or specify its name and select Open.

2. The Line data options dialog opens, as shown in [Figure 6 on page 33 Make

any changes as necessary and select OK.

A PC data file that did not originate on an iSeries does not contain information
about how many records form a page, nor what code page it was created with.
However, Infoprint Designer retains the spooled file attributes when it downloads

a file (they are stored in a file with the same name as the PC file and an
extension of .INF). Thus, if you selected a PC file that was previously
downloaded from your iSeries, the default values on the Line data options
dialog are taken from the spooled file attributes of the iSeries file. In this
situation, you should leave all or most values as they are. You might want to
change some of the values, as described below.

Code page

The code page should match the code page Windows is using on your
PC. Typically this is 437 (MS-DOS Latin 1 US) or 850 (MS-DOS Latin 1

Multilingual). If you are not sure which code page your PC is using,
enter chcp at a DOS prompt to display the active code page. When

Chapter 5. Using the Layout Editor
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referring to Windows documentation, the terms code page and
character set mean the same thing. This is not true with the IBM AFP
architecture.

Record format

Select variable record format with spooled files downloaded from the
iSeries, even though the iSeries is a fixed record format system. Also
select variable record format with spooled files from IBM mainframe
systems such as zOS. If you are extracting data from a spreadsheet
file, you might select fixed record format with a delimiter such as tabs or
commas.

Channel type

In this context, channel type refers to line spacing and page skip
controls that might or might not be in the data file. A more usual term is
carriage control or First Character Forms Control (FCFC).

ANSI A line space occurs before printing the line. Common ANSI
FCFC characters include a space (write, then perform one line
space), + (no space), 0 (two spaces), - (three spaces) and a 1
(write after skipping to a new page). The latter is also known as
a “Channel 1". ANSI line spacing control is the most common
channel type on the iSeries platform. If your spooled file
originated on the iSeries, this is the most likely choice for your
data file.

Machine
The data is printed, then any line or page skip controls are
performed after the data line.

No channel
No spacing or skip controls are present in the file. If this is the
case, you have a true “flat file” of data and you must specify the
page length carefully to ensure correct page breaks in the
layout.

Page length and width

If you are opening a PC file that was not downloaded from your iSeries,
use page length to specify how many records of data should appear in
each page of printed output. For page width, enter the length of the
longest record in the file.
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Figure 6. Line data options dialog

Setting layout properties

After you have selected the sample data to use for your project, the Layout
properties dialog is displayed, as shown in|Figure 7 on page 34|.

Chapter 5. Using the Layout Editor

33



34
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Figure 7. Layout properties dialog

On this dialog, you specify the basic properties of the layout, such as the size of the
paper you will print the project on, the orientation (landscape or portrait), how many
sides to print on (simplex or duplex), and whether this project requires the “constant
back” function of AFP. This function is for when you want to print an overlay but no
data on the back side of a duplex page. For example, this function could be used
when you have a terms and conditions overlay that does not get merged with data
from the spooled file at print time. Click OK.

Infoprint Designer uses your input on this dialog to set up the layout properties for
the first page of data.

After you get your sample data, you might want to specify the default font to use for
mapping data. To do this, from the Defaults menu, select Fonts.
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If your application also requires non-default settings for properties, such as what bin
to feed the paper from or the offset of the first line of data from the edge of the
page, you can change these settings. To specify non-default settings, from the Edit
menu, select Page properties and Print properties as appropriate.

Layout Editor windows

= Infoprint Designer - Layout editor - UNTITL.Prj (300 ppi) -10] x|
File Edit “iew Tool

After you have specified the basic layout properties, the Data window becomes the
active window. If you already have an overlay open, it moves to the background in
the View/Edit window. If the Data window does not open automatically, from the
Window menu select Data.

To display the Data and View/Edit windows side by side, from the Window menu,
select Tile.

The View/Edit window shows a different action toolbar when Infoprint Designer is in
Layout Editor mode. The title of the View/Edit window also changes to show the
name of the layout file you are working on, as well as the names of the AFP objects
inside the layout file. These changes are circled in .

Defaults  Window  Help

Top

Next

41 0000030
{*# FPlant 1
1* treat 1
{#1 0110051
h* Spread
I* cover w
1% TWater w
1#1 (045R987
4* Flant 1

Figure 8. Changes to the View/Edit window

The toolbar shown in the Infoprint Designer window is also slightly different in
Layout mode. It contains a navigation section with Top and Next buttons that
control which data page is shown in the View/Edit window using the mappings
defined in the layout. These changes are circled in|Figure 9 on page 38,

Chapter 5. Using the Layout Editor 35



= Infoprint Designer - Layout editor - UNTITL.Prj (300 ppi) - |I:I|£|
File Edit “iew Tool Defaulks “Window Help
DU =10l =] § ~
E B =B = RR DD
e L II.a*_:,n:uut |HEW I:IRFE-'I“lEI.‘_E,F|
L e Tl G I 5 T
4#1 0000030 <> .
_* Plant i I 1 1 1 1 I 1 1 1 1 I 1 1
4 treat 1 1T
4#1 0110051 !
h* Spread 1
4*  cowver w !
4% Tater w ] i
4#1 045/987 '
. 1% Flant 1 | -

Figure 9. Changes to the Infoprint Designer window

The Data window contains its own toolbar that includes a button that lets you to
customize the appearance of the data window. This button is circled in
[page 37 If you select this function then under Grid, select Rows, Infoprint Designer
adds lines to separate the records in the Data window.
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Figure 10. Options button on the Data window

After sample data file opens, the records in the Data window are either blue or red.
The set of records shown in blue represent the first page of data; the first record
shown in red represents the first record on the second output page. If this page
break does not look right to you, you might have to change the page length for this
data file. For instructions, see[‘Page breaks” on page 40.|If the page break is looks
correct, continue to [‘Mapping data to the layout.”|

Mapping data to the layout

Follow these steps to map data to the layout:

1.

In the Data window, select the field you want to map. If you want to map the
entire record of data, select the entire record, treating it as if it were a field. To
select a field, left-click at the beginning of the field or record (uppermost left
edge of data to map), and drag the mouse across the data to map. Release the
mouse button when all of your data is highlighted.

It is a good idea to have the documentation for the application you are working
on available. The data you see on the sample page you are looking at might not
represent the full length of the fields. For example, in the Invoice example in the
basic.prj sample supplied with Infoprint Designer, the original programmer’s
DDS code (not included) showed that the field NAME starts at column 12 and is
25 characters long. You can verify that you have the correct start position and
length of the field you are defining by watching the information displayed at the
top of the Data Window as you select the field. If you do not have access to
this information, test your new print application with as wide a variety of sample
data as possible.

Right-click the selected field and drag it to the View/Edit window. Release the
mouse button when it is positioned where you want the data to be.
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3. To edit the mapping, select it with the left mouse button in the View/Edit
window.

* To move the mapping, drag it elsewhere.

» To edit its attributes, from the Edit menu, select Object properties.
Alternatively, you can right-click the mapping in the View/Edit window to
display the Field properties dialog. From the General page, you can verify
the position from the original input record and field length against your
application documentation. Select any of the other pages to change the
attributes of the field, such as font or orientation.

In[Figure 11}, the Data window’s toolbar shows that we have selected Record
12, Field 12 to 36.
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Figure 11. Mapping and modifying a field

4. Continue mapping data on the first page until all of the fields you want to see
printed are displayed in the View/Edit window the way you want them to appear
in your final output. Data in the spooled file that you do not map is not printed
when you run the application on the iSeries.

You might find it easier to do the mapping on a gross level first, just dragging
and dropping the required fields over to their approximate destination in the
View/Edit window. Then minimize the Data Window and enlarge the View/Edit
window to fine tune the positions and make other changes to the field
properties.
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Mapping a column of fields

If a column of fields has similar attributes, you can define the field on multiple
adjacent records and map them in one step. To do this, use the left mouse button
to select across the first record in the group and then drag down until you have
selected the appropriate number of records.

Important: When you are selecting the number of records to include in the group,
be sure to consider what other pages of data in the spooled file might
contain. Select the largest possible number of records that might occur
in this group on any page in the file so that all pages are formatted
correctly. You can adjust this value (the Repeat count) later, but it is
easier to initially select the correct number of records.

shows the results of selecting and mapping a column of data across 25

records. The fields remain logically grouped so that any change you make to one

field (such as a move, change of font, or change of orientation) is applied to all
fields in the group.
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Figure 12. Mapping a column of fields

If you want to make changes to a group of fields, click the first element of the
group, and then either drag it to a new position or right-click it to change other
properties. To change the interline spacing of a group of fields, click any field in the
group, other than the first, and drag it up or down until the column is spaced to your
liking.
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Page breaks

The settings area of the Infoprint Designer window shows slightly different
information, depending on which field you select. If you select the first field in a
group, you will see its absolute position on the page. If you select other fields in the
group, you will see the position of the field relative to the first field as well as the
interline spacing (s).

Tip: If you have multiple columns of data of the same set of records, you can
adjust the line spacing of all the columns at one time. Click one of the fields in
one of the columns and hold Ctrl while you adjust the line spacing. All the
other columns that come from the same data records are adjusted accordingly.
You have to manually ensure that the fields for the first record in the group are
aligned.

You can use the Group printline (labeled Ungroup printline when a group is
selected) icon on the Action toolbar to ungroup a set of fields. However, after you
have ungrouped the fields, you cannot easily regroup them.

As you map data, you should stay within the records shown in blue in the Data
window. The blue records have been defined to belong to a single page; if you
map data from the red records following the blue records, you are changing the
page break for all subsequent pages.

If the number of records shown in blue when you first retrieve the spooled file is
fewer than you expect, map as many red records as you need to correct the page
breaks. Alternatively, you can follow the below procedure. If the number of records
initially shown in blue is more than you want to use, follow these steps:

1. From the Edit menu, select Layout.... The Edit layout dialog opens.

2. On the Edit layout dialog, select Options. The Line data options dialog
opens.

3. On the Line data options dialog, adjust the Page length value to match the
number of records you expect to map on every page of this layout.

To apply the mappings you have created to the second page of data in the spooled
file, select Next from the toolbar or select Data pages in the View menu. The
View/Edit window refreshes with the data from page 2 shown using the mappings
you defined for page 1. You should page through enough of the data file using Next
to verify that you mapped all of the data you need.

As you are mapping data and including overlays using the WYSIWYG functions of
the Layout Editor, the program builds the AFP resources called form definitions and
page definitions. These resources contain formatting instructions to map the input
data to the printed page. You will need to specify the names of these resources
when you print your application on the iSeries. For more information about form
definitions and page definitions see |Chapter 8, “Understanding page definitions and|
form definitions,” on page 63

Producing some common layout formats with the Layout wizard

After you have mapped your first page of data, use the Next button on the Layout
Editor toolbar to see how other pages will appear when formatted by your current
layout. You might find that you need to format some pages in the spooled file
differently. You might need to make minor adjustments, such as increasing the
repeat count on a group of mappings because you see that one customer has 18,
not 17, item records in their invoice, or you might need a different layout for some
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pages in the spooled file. For example, if the application writes a PAST DUE record
for customers who have not made prior payments, you might want to print that field
in a large bold font to call their attention to it. Alternatively, you might want to
produce a second copy of each invoice to use as a pick list in your warehouse, but
you want to suppress the prices from that copy.

The Layout Editor provides a wizard that steps you through modifying your project
to handle these types of common layouts:

» Print an identical copy of the page.

* Print a modified copy of the page with a different overlay or using paper from
another printer bin. See |“Changing overlays and suppressing data from a secondl
[copy” on page 43| for an example.

* Print a modified copy of the page with some data suppressed that prints on the
first copy. See |“Changing overlays and suppressing data from a second copy” on|

|page 43[for an example.

* Use a different overlay on the back side of a duplexed sheet.
» Format the data differently based on a trigger in the data file.

This section describes how to use the Layout wizard and includes examples of two
of these common layouts.

To use the Layout wizard, follow these steps:

1. Use the Top and Next buttons on the Layout Editor toolbar to display the page
that occurs immediately before the page for which you want to define a new
layout.

For example, if you notice that some of the invoices in the file contain two or
more pages for a single customer and you want pages 2 and above to look
different than page 1, use the Top and Next buttons to scroll to the first case
where a multi-page invoice exists in the sample data file and stop at page 1 of
the multi-page invoice.

2. In the View/Edit window, zoom to a level where you can easily select fields of
data that you have mapped.

3. Select the wizard tool from the View/Edit window action toolbar. The first page
of the Layout wizard appears.

Its contents are different depending on whether you have specified duplex in
your layout. The simplex version contains a few more options, since you can't
make changes such as which bin to select paper from when you are changing
sides of a duplex sheet, but you can if you are printing simplex output. Here is
the simplex version of the first Layout wizard page:
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What's different? i x|

How does the next page you want to print compare with the
displayed page?

' Same data, same layaut {identical copy)
" Same data, different modifications
(bins. owverlays. suppressions)

" Different (next page of) data, same layout

" Different (next page of) data“different layaut

[ Save project hefore starting the wizard

= Back I Mext = I Cancel

Figure 13. First page of Layout wizard for simplex project

If your project specifies duplex and the page displayed in the View/Edit window
is the front side, this is the first page of the Layout wizard:

How does the back side compare with the front side?

™ Different data fields Sﬂjpressed or printed

[ Different farmat

= Back I Finizh I Cancel

Figure 14. First page of Layout wizard for duplex project, page displayed is front

If your project specifies duplex and the page displayed in the View/Edit window
is the back side, this is the first page of the Layout wizard:
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What's different? : x|

Haowr does the next page you want to print compare with the
displayed page?

* Same data, same layout (identical capy)
" Same data, different madifications
(hins, owverlays, suppressions)

" Different (next page of) data, same layout

" Different (next page of) data, different lawout

[ Save project before starting the wizard

= Back I et = I Cancel

Figure 15. First page of Layout wizard for duplex project, page displayed is back

Notice that you get different choices in all three cases because the wizard only
shows you what is possible to change in your layout based on what kind of
page you are going to format: a simplex page, the back of a duplex page, or the
front of a duplex page.

Changing overlays and suppressing data from a second copy

Let's take as an example the scenario where you are printing a simplex invoice and
you want to print a second copy of each sheet, but want to suppress the prices on
the second copy. This application currently prints on impact printers using multipart
forms, but you want to re-engineer it to use plain paper on laser printers. Since the
overlay you used for the first copy includes columns for the prices, you will use a
different overlay on the second copy that does not show those columns. You can
use the sample project supplied with Infoprint Designer as
C:\Designer\PROJECT\basic.prj to follow this example.

Before starting this example, follow these steps:

1. Make a copy of the sample project C:\Designer\PROJECT\basic.prj and save it
with a different name. We will use the name copies.prj.

2. Copy the file C:\Designer\PPFA\basic.pfa and rename it copies.pfa.
3. From the File menu, select Open project to open the copy (copies).

4. From the Edit menu, select Layout to change the name of the layout file. In the
Layout file field, specify the same name you gave the copy of the project. For
our example, we will name it copies.pfa.

5. From the File menu, select Save project.

To make a copy of the invoices that prints with a different overlay, follow these
steps:
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1. Assuming you have mapped the first copy the way you want it, when you start
the Layout wizard, the dialog shown in|Figure 13 on page 42| opens.

2. Select Same data, different modifications (bins, overlays, suppressions)
because you want to suppress some data on the next page, as well as change
the overlay. The Start Another Copy dialog displays, as shown below:

Start Another Copy x|

To begin the new copy do you want to:

* Startfrom an existing copy:

Copy group: |copvt |

Subgroup: |SUE|GROUP1 =

" Startwith an empty copy

Mame of new subgroup.

= Back I Mext = I Cancel

Figure 16. Start Another Copy dialog

3. The copy group is the part of the layout that defines the overlays and
suppressions. There is one subgroup for each copy of the page of data that you
print, so you need to create a second subgroup. For more information about
copy groups and subgroups, seelChapter 8, “Understanding page definitionsl
[and form definitions,” on page 63.]

Because the number of changes you want to make is small, select Start from
an existing copy. The copy group you already defined for the first copy is filled
in by default. In the Name of new subgroup field, name the new subgroup to
be used for copy 2. We will enter NOPRICE. Select Next.

4. The Modified Copies dialog appears:
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Modified Copies x|

Specify the modifications you want for this copy.

Copy group: CORYT
Subgroup: SUBGROUPT <copyi>

[T Different overlay(s)
[ Ditferant data fizlds suppressed of printed

[™ Different input or output bins

= Back I Mexd = I Cancel

Figure 17. Modified Copies dialog

Select Different overlay(s) and Different data fields suppressed or printed
and select Next.

5. The Overlays dialog opens:

Specify the modifications you want for this copy.

Copy group: COFYT
Subgroup: SUBGROURPZ <MOPRICE>

Drvetlays:

[MWOIC

Delete

Change

Il

= Back I et = I Cancel

Figure 18. Overlays dialog

To replace the overlay you had on the first copy (INVOIC) with the overlay for
the second copy (PACK), select INVOIC in the list and select Change. Browse
to PACK.OGL and select open. PACK is now shown as the overlay for the
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[ second copy. Select Next.
| 6. The Suppressions dialog opens:

Suppressions il

Selectthe field(s] in the VWiew/Edit window that you want to
suppress in this copy. Then enter a name for this set of
suppressions and select Define,

Copy group: COFYT
Subgroup: SUBGROURE <MOPRICE>

Marme: I Define |
Active DFLT Delete |
SUppressions:

= Back I et = I Cancel

Figure 19. Suppressions dialog

[ Use your mouse in the View/Edit window to select any mapped fields that you
| do not want to appear on the second copy. Use the Shift or Control key with the

[ left mouse button for multiple selection.

example, PRICE). This is shown in [Figure 20 on page 47}
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For this example, select the first field that is mapped in the Price column of the
overlay and the first field mapped in the Extension column. When both of the
fields you want to suppress are selected, select the Name field on the
Suppressions dialog and enter the name for this suppression group (for
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Figure 20. Selecting fields and naming the suppression group

Select Define and PRICE moves to the list of active suppressions. Select Next.

7. The next dialog asks if you want to make another modified copy. When you

select No and then Finish, the second copy is shown. |Figure 21 on page 48|
illustrates this.

Note: If you make any adjustments to the data placement on this copy, those
changes will also be made on the first copy.
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Figure 21. Second copy of the first invoice

8. Use the Next button on the Layout Editor toolbar to see copy 1 of page 2 of the
data. When you click Next again, you will see copy 2 of page 2, and so on.

Changing the format based on a trigger in the data

48

One of the most powerful tools in AFP is the ability to change the output format
based on the print data itself. This function is called conditional processing. When
you use conditional processing, you test the contents of a field of data. When it
changes or meets a condition (called the trigger), such as matching a constant
value, you switch to a different overlay or new layout on a new side or sheet of the
output. When setting up conditional processing, you need to understand all of the
possible cases that could be found in the spooled file and make sure you know how
each should be handled before using the wizard. In this section, we will modify one
of the sample projects provided with Infoprint Designer to use conditional
processing to produce different formatting for the individual pages of a multi-page
invoice.

Before starting this example, follow these steps:
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Make a copy of the sample project C:\Designe\PROJECT\basic.prj and save it
with a different name. We will use the name wizard.prj.

Copy the file C:\Designer\PPFA\basic.pfa and rename it wizard.pfa.
From the File menu, select Open project to open the copy (wizard).

From the Edit menu, select Layout to change the name of the layout file. In the
Layout file field, specify the same name as you gave the copy of the project.
For our example, we will name it wizard.pfa.

From the File menu, select Save project.

Use the Top and Next buttons on the Layout Editor toolbar to scroll through the
file.

The first page of the file is a 1-page invoice for the customer Improved Printing. The
second page of the file is the first of three pages of an invoice for the customer
Organic Garden Supplies. You can tell that the first of the three pages is not the
final one because the word “Continued” appears in the “Total Due” field at the
bottom of the rightmost column of items, as shown in

|# Infoprint Designer - Layout editor - wizard.prj (300 ppi) - [View/Edit - WIZARD.PFA - BASIC,COPY1,5UBGROUPO / - = x|
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Next
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Figure 22. "Continued” in Total due field

We will use the string “Continued” as a trigger to set up conditional processing. We
want to show the actual amount due in a large bold font and the string “Continued”
in an italic font in the shaded box labeled TOTAL DUE on the overlay. To
accomplish this using the Layout wizard, follow these steps:

1.

2.

With WIZARD.PRJ project open to the first page in the file, zoom the contents
of the View/Edit window and use the right mouse button to select the total
amount field, $90,652.21.

When the Field properties dialog opens, select the Font 1 page. We want to
show the total in a larger bold font. Specify these values:

* For Size, select 12.
e For Weight/Width/Design, select Bold/Medium/Normal.
* For Code page, select the first entry of International #5.
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Press OK on the Field properties dialog.
3. The font changes are shown in the Layout Editor window.

Because we know that the second page in the spooled file is the first page in a
multi-page invoice, we will use the Layout wizard to help us change the format for
that page so that the Total field we just made bold on the first invoice will be italic
when it says “Continued” instead of giving a numeric value.

4. From the first page (because we are going to change the next page), select
the wizard tool from the View/Edit window action toolbar.

5. On the first dialog select Different (next page of) data, different layout, then
select Next.

6. The Define a Field dialog is displayed. This lets you identify the trigger in the
sample data file that is used to select the correct format for each page in the
file. As instructed on the dialog, go to the Data window and select the field to
test (this is the trigger field). In this case, there is an actual total instead of the
word “Continued”. However, on the pages where the field will contain the string
“Continued”, it is placed in the same location as the total amount due; columns
70 - 78 of record 51. To identify the trigger, follow these steps:

Select columns 70 - 78 of record 51. This is from the $ to the 2, do not

include anything else. The completed Define a Field page is shown in

If you accidentally selected the whole total amount, the Length

field shows 10 and you can type over that with a 9.

Select the Condition field and name this condition CONTINUED.

a.

Select Next.
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Figure 23. Completed Define a Field page

7. On the Define a Test page, select EQ (=) and enter Continued in the Text
field. Select Next.
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Define a Teskt

Define the test ywou want to perform on the contents of the field.

Condition: COMTIMNUED

~ Test
" Change
@ EQ() " NE (1=) G
i GE (=) LT (<)  LE (<=)
Text: ICDntinued [ Hex

= Back I et = I

Cancel

Figure 24. Completed Define a Test page

8. On the Define an Action dialog, select Change layout and then for Page

format select New.

A field appears for you to name the new page format you want to use. Enter

Contd. Notice the options at the bottom of the dialog that let you specify when
the action should take place. The default value, Before SubPage, means that
Infoprint Designer performs the test on the contents of the field and if the test

result is TRUE, it reprocesses the page with the changes indicated. You could,

for example, use this function to skip to a new page after testing a field for a
specific value. In our example, we want Designer to reprocess the page with
the new page format, so we leave these options with the default values then

select Next. The completed page is shown below:
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Define an Action : x|

YWhat action do you want to occur when the test result is
TRLUE?

Condition: CONTINUED

Action:
* Change layout

INEW 'I page format ICDntd|
ICurrent vI COpYy group

" Goto new side

" Goto hew sheet
When do you want the action to take place

Befare j currert ISubPage j

= Back I et = I Cancel |

Figure 25. Completed Define an Action page

Note: You could also use this test to change the overlay that is used on the
“Continued” page. Because overlays are named in a copy group, you
would need to select New in the Copy group list and name a copy
group to be created. For more information about which layout properties
are in the page format and copy group, see [Chapter 8, “Understanding|
[page definitions and form definitions,” on page 63.|

9. Because you specified to create a new page format, the Start a New Layout
dialog lets you create the new format as a copy of the old or to start with an
empty format. When there are few changes being made, it is easiest to create
the new format as a copy of the old. The only change we want to make is to
the font in the Total field, so we select Next to start the format for the
Continued page as a copy of the current format (hamed PAGEL1).

You have finished specifying what should happen when the field contains the string
“Continued” (we will change the font to italic later). Now you need to specify what
happens by default, that is, when the field contains something else.

10. On the What’s Next dialog, select Define what happens by default and
select Next.

Note: If you have different strings you want to test for in this field, you would
instead select Define a new test on this field and then you could
specify, for example, what should happen if the string was greater or
less than a certain value.

11. If the string is not “Continued,” we want to use our original page format,
PAGEL, to format the data. So in the Define an Action dialog that appears,
select Change layout. Select Existing page format and PAGEL as shown
below, then select Next.
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Define an Action x|

YWhat action do wou want to occur by default?

Condition: continued

Action:
i« Change layout

~ | page format FAGET j

ICurrent vI COPY group

" Goto new side
" Goto new sheet

YWhen do wou want the action to take place

Befare j currert ISubPage j

= Back I et = I Cancel |

Figure 26. Specifying what to do when the field does not contain Continued

12.

13.

14.

The What's Next dialog reappears. Notice that this time the middle choice is
not available because you have already specified the default action for this
condition. Select Preview the results of this condition so that you can check
your work and select Next.

On the Preview Results dialog, select Apply the condition to the next data
page and then Finish.

On this dialog, you could also specify to apply the test to the page you are
currently viewing or force Designer to take a path other than the one that the
contents of the field would dictate. This helps you test your conditional
processing when your sample data file does not contain all of the cases that
you expect to find in the actual spooled file.

The second page of the spooled file shows in both the Data window (in blue)
and in the View/Edit window. Notice that the title bar of the View/Edit window
shows that the active page format is CONTD instead of PAGEL, as shown in
|Figure 27 on page 54|. This indicates that you are now using the page format
you specified to use when the field contains the string “Continued.”
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Figure 27. Previewing the results of the Wizard

To make the string “Continued” italic, select it in the View/Edit window and
right-click. In the Field properties dialog, select the Font 1 page. Because
there is not an italic version of the Letter Gothic Latinl typeface you were
using, select the values below, then select OK:

* From the Typeface list, select Helvetica Latinl.

* In the Weight/Width/Design list, select Medium/Medium/Italic. This choice
appears after you select Helvetica Latin1.

* In the Code page list, select the first International #5.

The “Continued” field on the page changes to italic.

15. Use the Next button on the Layout Editor toolbar to page through the sample
data file and watch for the page formats to change between PAGE1 and
CONTD. Save your project if you want to keep it for future reference.
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Chapter 6. Using your AFP resources with your iSeries

application

After you have designed the overlays and layout, it is time to compile them into AFP
resource format (this is done automatically) and upload them to your iSeries
system.

To upload your resources to the iSeries, follow these steps:
1. On the File menu, select Upload to iSeries....
2. On the Contents page, specify what you want to upload.
» Specify Selected overlay or layout option to upload the active overlay or
layout. If the active window is the overlay editor, the overlay is uploaded.

Fonts and page segments defined in the overlay might be uploaded,
depending on settings on the iSeries page.

If the active window is the layout editor, the page definition and form
definition is uploaded.
» Specify Whole project to upload the layout file (page definition and form
definition) and all of the overlays defined in the project.
Fonts and page segments defined in the overlay might be uploaded,
depending on settings on the iSeries page.
3. On the iSeries page, select the iSeries library in which you want Infoprint
Designer to place your resources.
The Send area specifies whether fonts and page segments are uploaded. In
this area, specify whether you want fonts and page segments to replace files
with the same name when they are uploaded.
In the Prefix area, select the prefixes you want Infoprint Designer to add to your
file names. For more information about prefixes, see [‘Understanding file names’
4. Your specified objects are compiled and placed in the specified library on the
iSeries.
The layout file produces two AFP resources on the iSeries; the page definition
and the form definition. Each overlay produces an iSeries overlay object.

Note: Each time you upload an overlay to the iSeries, it replaces any file with the
same name in the library. You can control whether a form definition and page
definition on the iSeries with the same name are replaced.

To control whether the form definition and page definition are replaced, follow these

steps:

1. From the Window menu, select Form definition or Page definition.

2. In the tree window that opens, right-click the form definition or page definition
name. The Form definition properties or Page definition properties dialog
opens.

3. On the Name page, for replace select Yes or No.

4. Select OK.

Once the resources are on your iSeries, you can use them with an application. If
you use Infoprint Designer to create overlays and page segments without using the
layout function, you can include them in your V4R5 or higher applications by using
one of these:
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* The FRONTOVL and BACKOVL keywords on the CRTPRTF, CHGPRTF, or
OVRPRTF commands

* The OVERLAY and PAGSEG keywords in DDS.

If you created a layout with Infoprint Designer, you downloaded a sample spooled
file from your iSeries. That spooled file is not sent to the iSeries when you upload a
project. To use the new layout resources with that application, you must make some
changes to the iSeries printer file that the application uses and then rerun the
application.

As with all AFP resources, the iSeries must be able to find the new resources in an
accessible library list. For testing, you can add any resource libraries to your own
library list (EDTLIBL). For batch applications, add the libraries to the Device resource
library list in the PSF configuration object or to the job’s library list. Use the Create
PSF Configuration (CRTPSFCFG) or Change PSF Configuration (CHGPSFCFG)
command to specify the Device resource library list:

Name

Name, *LIBL, *CURLIB

*SAME, *JOBLIBL, *CURLIB...
Name, *SAME, *DFT

*SAME, *NO, =*YES

*NORDYF, +IMMED...
1-1440, *NOMAX, =SEC15...
1-1440, *IMMED, *SAME
1-99, =SAME, =*NOMAX
0-999, =*SAME

1-32767

5-3600, *NOMAX, *SAME

4 Change PSF Configuration (CHGPSFCFG)
Type choices, press Enter.

PSF configuration . . . . . .. > TEST
Library . . . . . . . . ... *IBL
User resource library list . . .  *JOBLIBL

Device resource library list . .  *DFT
+ for more values

IPDS pass through . . . . . .. *NO
Activate release timer . . . . . *NORDYF
Release timer . . . . . . . .. *NOMAX
Restart timer . . . . . . . .. *IMMED
APPC and TCP/IP retry count . . 15
Delay between APPC retries . . . 90
Acknowledgment frequency . . . . 100
Printer response timer . . . . . *NOMAX

...... *NONE

Generate PDF output
-

*NONE, *SPLF, =STMF, *MAIL...

Figure 28. Change PSF Configuration screen
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To use your new layout resources, with your application, follow these steps:

1. Determine what printer file your application uses. To do this, on the iSeries, use
the WRKSPLF command to display a list of spooled files and select option 8,
Attributes. A screen like this opens:
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Work with Spooled File Attributes
Job . . . . .. .. : QPRTJOB File . . . . . . . . : INVSCS
User . . . . . . .: SIMON Number . . . . . . : 1
Number . . . . . . : 235527
Device type . . . . . . . . . ... L PRINTER
Printer device type . . . . . . . . . : *SCS
Device file . . . . . . . . . . . . .t QSYSPRT
LAY 0 06 0 0 06 0 06 0 0 0 0 0 0 o 8 QSYS
User-specified data . . . . . . . . . : SSS.COM
Accounting code . . . . . . . . .. L 982806
Program that opened file . . . . . . :
Library . . . . . . . oo oo oL
Date file was opened . . . . . . . . : 03/26/01
Time file was last used . . . . . . . : 15:53:41
Date file was last used . . . . . . . : 03/26/01
System where file created . . . . . . : BLDAS45
User who created file . . . . . . . . : SIMON
More...

\Fress Enter to continue.

Figure 29. Identifying the printer file that created the sample spooled file

The value shown for Device file is the name of the printer file that you need to
modify. In the printer file is QSYSPRT in library QSYS. The “Q” prefix tells
us this is an IBM-supplied printer file, and IBM does not recommend
permanently changing this file because screen prints and other output might be
affected. In this case, we will temporarily override the QSYSPRT printer file before
the application program is rerun.

If you cannot change the printer file or you do not have access to the iSeries
application program, you might be able to copy the printer file being used or to
create a new one. Your new one must have the same name as the original
printer file because the application refers to it by name, but if you store the
modified printer file in a library higher up in the library list than the original
printer file, the new printer file is found first and used for the job. If you do this,
any job that uses the original printer file will now use the modified one instead.

2. Use either the Override with Printer File (OVRPRTF) or Change Printer File
(CHGPRTF) command to change the printer file attributes. The OVRPRTF
command is temporary and the CHGPRTF command is permanent. Run the
OVRPRTF command immediately before you run the application program. You
can enter the CHGPRTF command at any time. Make these changes to the
printer file to use the Infoprint Designer resources with your application output:

Parameter Value Special Notes

Device type *LINE

Page definition |name of page This is the same name as the layout.
definition

Form definition |name of form This is the same name as the layout.
definition

Duplex *FORMDF Specify only if this functions is specified your

Infoprint Designer layout.
Drawer *FORMDF Specify only if this functions is specified your

Infoprint Designer layout.

Chapter 6. Using your AFP resources with your iSeries application
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Parameter Value Special Notes
Convert line *YES Specify only if you are sending this output to a PCL
data printer with the Host Print Transform. This ensures

that the resulting spooled file is converted to
AFPDS. This function requires V5R1 of OS/400
and PTF S102688 or V5R2 of OS/400.

The command syntax, with all of the optional parameters specified, follows:
XxxPRTF FILE(printer-file-name) DEVTYPE(*LINE)

Infoprint Designer for iSeries: Getting Started
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Chapter 7. Using the Image Editor

The Image Editor provides a comprehensive platform for the design and creation of
image data for iSeries applications. With a typical image object, such as a logo, you
need to scan the image from high-quality input (usually “camera-ready” artwork).
Alternatively, the image can be imported in digital format, such as TIFF, BMP,
JPEG, GIF, ICO, or PTR, if it is available. The Image Editor produces TIFF format
images or AFP page segments as output.

Input images can be color or bi-level (that is, black and white) and should be
scanned at the resolution of your target AFP printer (240 dpi, 300 dpi, or 600 dpi).

The Image Editor can be used for both touch-up and image enhancement.
Touch-up is the process done with scanned images where extraneous dots left from
the scanning process are eliminated and missing dots are filled. Touch-up ensures
that the imperfections created during the scanning process are eliminated and that
you end up with the sharpest, cleanest image for printing.

Starting the Infoprint Image Editor

There are two ways to start the Infoprint Image Editor:

* Double-click on the product icon that you put on your desktop: :
* From the Start menu, select Programs and then IBM Infoprint Image Editor.

If you do not have an active connection to the first iSeries defined in your iSeries
Access connection list, the Connect to iSeries dialog displays, where you select
the iSeries host that is licensed for use with Infoprint Designer and enter your user
ID and password on that system. If you want Infoprint Designer to save these
values, select Save User ID and Password.

If you click Cancel on this dialog or are unable to get a connection with the
licensed iSeries, Infoprint Designer displays a message that the program will start in
demo mode, where you cannot save your work. If this happens in error, close the
program and start it again when you can connect with the licensed iSeries system.

When you start Infoprint Image Editor, it automatically opens in new image
(drawing) mode. The light green frame indicates the borders of the image. The
resolution and image size for the new image are taken from program defaults of
240 dpi and 152 x 152 pels. You can change these default values by opening the
Defaults menu and selecting Size/resolution. You can customize Image Editor’s
startup in these ways:

* You can set up the Image Editor to open in drawing mode, but prompt you for the

size and resolution values for the new image. To do this, open the Defaults
menu and deselect Use defaults for new images.

* You can set up the Image Editor to require you to select New or Open to begin
your work. To do this, in the Defaults menu, deselect Start in new image mode.

Working with the Infoprint Image Editor Window

[Figure 30 on page 60| shows the Infoprint Image Editor window. The labeled areas
are described in detail below.
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Figure 30. Infoprint Image Editor window

Parts of the Infoprint Image Editor Window:

1. Navigation window: This window shows the entire image. A small square
shown in the Navigation window tracks the pointer as you move it inside the
image. This is useful when you are zoomed in to a section of the image and
also need to see where the zoomed section is in relation to the complete image.
When you click in the Navigation window, the contents of the Image Editor
window scroll to show the area that you clicked in the center of the Image Editor
window.

You cannot resize the Navigation window. But you can reposition it by grabbing
an edge and dragging it. You can remove the Navigation window from the
display by opening the View menu and deselecting Navigation.

2. Editing toolbar: Provides access to the most frequently used file, edit, and
view functions.

3. Drawing toolbar: Provides access to the drawing and image editing tools.

Some functions on the toolbars, such as delete, cut, copy, and fill area, are not
available unless you have selected an area of the image. To select an area, click

the selection mode icon on the drawing toolbar: . Press and hold the left
mouse button down at the top left corner of the area you want to select and move
the pointer to the bottom right corner of the area and release the mouse button.
The selected area is shown surrounded by a thin frame.

To edit individual pels in the image, select the Pencil icon on the drawing toolbar.
Position the pointer on the pel you want to edit. When you left-click, the pel is
colored according to the primary color selected in the Primary/Secondary Color
Definition dialog. When you right-click, the pel is colored according to the
secondary color. In the case of black and white images, left-clicking colors pels
black, and right-clicking turns black pels to white.
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Hints and tips for the Infoprint Image Editor

Use these tips to help you draw new images or touching up existing ones:
* A zoom factor of at least 6:1 is useful, especially for touch up.

» To set the size of the pencil and the thickness of lines you draw, open the
Defaults menu and select Drawing size....

» To display a grid that shows each pel, open the View menu and select Grid.

* AFP page segments contain their rotation information inside the page segment.
Therefore, if you want to print an image such as a logo in more than one
orientation, you must create two different page segments, one at each
orientation. Use the Image Editor's Rotate function to orient the image correctly
and then save it as a page segment with a different name (such as LOGO90 for
the version of the logo that is rotated 90 degrees from the standard logo).

Using your images with iSeries applications

After you have created TIFF images or AFP page segments, you can include them
in overlays and layouts produced with Infoprint Designer. Infoprint Designer will
convert your bilevel TIFF images to AFP page segments. In order to use color page
segments, you must save them as an AFP page segments in Image Editor before
using them with Infoprint Designer.

Using the Upload to iSeries function in Infoprint Designer, you can have all of the
page segments defined in a project sent to the iSeries for use in the print

application. For more information, see ['Uploading your overlay to the iSeries” on|
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Chapter 8. Understanding page definitions and form

definitions

Layout is the process of mapping application data from an iSeries spooled file to
the printed page. In AFP, two resources are used to perform the layout function: a
page definition and a form definition. These resources are used to format the output
of application programs for high-quality printing without requiring
application-dependent programming. This separation allows you more flexibility in
changing your physical print requirements, such as duplex and paper tray selection,
without affecting the formatting properties, such as fonts and orientation. When
working with complex applications, it is important that you understand how page
definitions and form definitions interact with the logical page and the physical page:

page definition
The AFP resource used to place data onto a logical page.

form definition
The AFP resource used to place the logical page on the physical page.

logical page
The formatted page of data that is positioned on one side of a physical
sheet of paper. It can be thought of as an “imaginary” page.

physical page
The actual sheet of paper.

The layout file that you create using Infoprint Designer is converted to a form
definition and page definition when you upload the layout to the iSeries. For simple
layouts, you do not need to understand the finer points of the contents and
structure of page definitions and form definitions, but more complex layouts require
a deeper understanding of these resources. Use this chapter to learn more about
page definitions and form definitions.

If you require an even greater level of understanding of page definitions and form
definitions, refer to Page Printer Formatting Aid: User’s Guide.

Page definition and form definition functions

When you are migrating your iSeries application that produces SCS or line data to
take advantage of the formatting capabilities provided with AFP, you need to create
both a page definition and a form definition to be used when printing the job. The
page definition is very application-specific; form definitions are often reusable by
several applications. This section describes which AFP functions are performed by
each of these two AFP resource types.

As was stated above, a page definition contains the instructions for formatting line
data onto logical pages. Settings such as the size of the logical page, its orientation
(portrait or landscape), and the position of the first line of data relative to the logical
page origin, are defined in the page definition.

The page definition contains all of the specifications for mapping each record of a
data file onto the logical page, including the font (possibly a bar code font), rotation,
and interline spacing. The page definition can also be used to place a text string, an
overlay, or a page segment relative to the position of a field of data. Controls in the
page definition can be used to produce multiple-up output.
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A form definition controls how a logical page of data is placed on the physical
paper. The form definition contains specifications for print properties, such as
duplexing, number of copies, input and output bins, finishing options such as staple
and punch, and number of copies. The form definition also nhames all of the
fixed-position overlays to be printed as well as whether to merge application data
with those overlays or not. Controls in the form definition can be used to produce
N-up output, where up to four logical pages of data can be printed on a single side
of a sheet.

Page definitions and form definitions both contain controls that work together to let
you suppress selected fields from printing on some copies of your output, but print
the same fields on other copies.

Migrating existing page definitions and form definitions

If you have page definitions and form definitions in AFP object format, you
cannot import these files into Infoprint Designer. However, if you have source files in
Page Printer Formatting Aid (PPFA) format, you can use these layout files with
Infoprint Designer.

To use PPFA source files, do one of these:
» To start a new project with a PPFA source file, follow these steps:
1. From the File menu, select New project....

2. On the New project dialog, in the Start with field, select Layout definition.
In the Layout file field, select or enter the name of the PPFA source file.

You might want to save the changes you make using Infoprint Designer into a file
with a different name because the .PFA files that Designer creates cannot be
used with PPFA programs on iSeries or other operating systems.

» To use a PPFA source file after you have already started a project, from the Edit
menu, select Layout... and select or enter the name of the PPFA source file in
the Layout file field.

Restrictions when importing PPFA source files:

1. Infoprint Designer does not support some PPFA functions, such as media
information in the form definition. If the PPFA source file you import into Infoprint
Designer contains valid PPFA commands for unsupported functions, the PPFA
commands are retained in the source file and are compiled into the page
definitions and form definitions created when you upload your project to the
iSeries.

2. Infoprint Designer does not support any functions accessed by including AFP
structured fields in the input data. Records such as Invoke Data Map and
Include Page Overlay are not processed by Infoprint Designer if they are
encountered in the sample data file used for layout editing.

Page definition and form definition structure

The page definition and the form definition each has its own hierarchical structure.
Each resource contains additional components that are introduced in this section.

Page definition structure

Each page definition contains one or more subsets, or page formats. Each page
format contains the formatting instructions for a single logical page of data. Settings
such as the size of the logical page, its orientation, and the position of the first line
of data relative to the logical page origin are defined in the page definition but can
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also be specified in the page format. You can change the values for these settings
for the active page format by opening the Edit menu and selecting Page
properties....

If your application requires more than one type of page layout, you need to create
more than one page format. To switch page formats, you must define fields in the
application data that can be tested to determine which page format to use. For
example, look in columns 50 through 58 of the 55th record for the word “Continued”
to switch to a page format that formats the next logical page of data differently than
the format used for the first page of output. This process of testing the data to
determine what page format to use is called conditional processing. The Layout
wizard can make this process easy for you, so you do not have to work directly with
page formats. For a simple example of conditional processing, see |“Producing|
|some common layout formats with the Layout wizard” on page 40.|

A page format contains one or more subpages. A subpage is a part of the logical
page on which data might be placed. Subpages are used for conditional processing
and for multiple-up printing. The subpage does not contain any formatting
instructions; it serves as a divider in the page format to logically group data records.

A subpage contains one printline for each record in the input data file. The printline
specifies all of the formatting instructions (such as position, font, and orientation) to
be used for its corresponding data record. One printline might span multiple data
records if the records contain carriage control characters that merge data from
multiple records. Page segments and page overlays can be associated with a
printline. Conditional processing instructions are associated with a specific printline.

Each printline contains instructions for its fields, which are the individual pieces of
data, like a customer name or address, that you map onto the page.

With Infoprint Designer, you map fields of data from records in the data file. These
mapping operations create fields on printlines in the page definition. When you
select a field in the View/Edit window, a small blue anchor symbol appears, usually
along the left edge of the window. This anchor symbol represents the printline to
which the selected field belongs. You can right-click the anchor symbol to change
the properties of all the fields defined on that printline.

When the page definition is processed at print time, the printlines are applied to
data records in sequence unless a channel code is encountered on a data record.
Channel codes can be placed in the first character position of a data record to
indicate a formatting change. The most common example of a channel code is a “1”
being used to indicate a skip to a new page.

Printlines can have channel codes associated with them, so that when a data
record is encountered with a channel code, processing skips to the next printline
that has that channel code associated with it. Use the Printline properties dialog
to associate channel codes with printlines if your application data contains channel
codes. To access the Printline properties dialog, right-click the appropriate field
and the Field properties dialog opens. Select Printline properties.

When you start the Layout Editor, Infoprint Designer builds a page definition with a
single page format and a single subpage. Infoprint Designer uses information it
retrieves from the Page length attribute of the iSeries spooled file to determine how
many printlines to create in the page format. If you use a PC file to create your
layout, Infoprint Designer uses the Page length value you specified in the Line
data options dialog when you loaded your sample data to determine the number of
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printlines. This default page definition is named UNTITL and the default page format
is named PAGE1. To see the structure of the page definition you create using the
Layout Editor, from the Window menu, select Page definition. The Page
Definition window that opens depicts the hierarchical structure of the page
definition, as shown in
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Figure 31. Page Definition tree structure for Basic sample

In the Page Definition window, the entries for Rnn correspond to the individual
records in the data file and the entries for Fnn correspond to the fields you defined
as you mapped data. You can drag objects from the toolbar in the Page Definition
window to add new fields or record mappings to the page definition.

Form definition structure

66

Each form definition contains one or more copy groups. Each copy group contains
the print instructions for a single physical sheet of output, including both the front
and back sides of a duplexed sheet. Settings such as the placement of the logical
page on the physical paper, duplexing, stapling, and printer input and output bins,
are defined in the form definition but can also be specified in the copy group.

A copy group contains one or more subgroups. A subgroup is the set of print
instructions for one side of a duplexed sheet of output. The subgroup specifies the
number of copies of each page of data that are to be printed and any modifications
to be made to each copy, such as different overlays or suppressed fields in one
copy that are printed in another. The subgroup also defines any medium overlays to
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be printed. Subgroups are commonly used for applications that are migrating from
multi-part forms, where multiple copies of the same page of data are printed with
modifications possible between copies.

To change the values for settings in the active copy group, open the Edit menu and
select Print properties.... You might want to change copy groups within a layout if
you want to print on different stock (colors, sizes) for some pages of the output of
your application than for others. Changing copy groups is controlled by conditional
processing specifications in the page definition.

When you start the Layout Editor, if you specified one-sided (simplex) printing on
the Layout properties dialog when you created the layout, Infoprint Designer builds
a form definition with a single copy group and a single subgroup. The subgroup
contains a reference to any overlays you have defined in the project. This default
form definition is named UNTITL, and the default copy group is named COPY1.

If you specified two-sided (duplex) printing on the Layout properties dialog,
Infoprint Designer builds a form definition with a single copy group and two
subgroups, one each for the front and back sides. The FRONT stubgroup contains
references to any overlays you have defined in the project.

To see the structure of the form definition you create using the Layout Editor, from
the Window menu, select Form definition. The Form Definition window that
opens shows the hierarchical structure of the form definition. A simplex example is

shown in
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Figure 32. Form definition window
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Working with the tree windows

You can work directly with the tree structure of the page definition or form definition
by using the toolbars in the Page Definition and Form Definition windows. The
toolbars contain icons for each of the component objects (for example, page format,
subpage, and printline for page definition). You can add, delete, reorder, or copy
each of these objects using the toolbar icons as described in this section.

Be careful when you are using these windows—changes you make to the page
definition can change the page breaks for the entire layout. It is a good idea to use
the Top and Next buttons on the toolbar to scroll through the data to ensure that
the changes you make in the Page Definition window are appropriate for all of the
pages in the print job.

Adding an object to the tree structure
Follow these steps to add an object to the form definition or page definition:
1. On the toolbar, select the icon representing the object you want to add.
2. Drag the icon to the appropriate position in the tree.
3. When the icon is positioned in a valid location, release the mouse button.

Note: If you try to drop the icon in a position that is not valid, a red X appears
on the icon.
Notes:

1. When adding a copy group or subgroup, IBM recommends that you copy the
original objects (COPY1 and SUBGROUP1) rather than add a new object. Copying
the original objects ensures that the default suppressions defined when the
layout project was started are used in the copy as well.

| 2. Be careful when adding print lines, as it can cause “off the page” errors if you
| add too many.

Deleting an object from the tree structure
Follow these steps to delete an object from the page definition or form definition:
1. Select the object you want to delete in the tree structure.
2. On your keyboard, press Delete.

Notes:
1. Objects defined inside the deleted object are also deleted.

[ 2. When adding deleting print lines, be careful that you do not accidentally delete
| printlines that map data on the page.

Reordering objects in the tree structure

The order of objects in a page definition or form definition is relevant to how the
printed output appears. Follow these steps to change the order of the objects in the
tree structure:

1. Select the object you want to move in the tree structure.
2. Drag the object to its new location.
3. When the icon is positioned in a valid location, release the mouse button.

Note: If you try to drop the icon in a position that is not valid, a red X appears
on the icon.
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Copying an object in the tree structure

You can use this copy function when you set up conditional processing to switch to
a new page format and you need to specify the mappings and other properties of
the new page format. In most cases, the new page format is only a slight variation
of the old one, so you might want to define the new page format by editing a copy
of the old page format. The same rationale applies to subgroups and copy groups
in the form definition. To copy an object (and all of its associated lower-level
objects), follow these steps:

1. Press and hold Ctrl while you select the object to be copied.

2. Holding Ctrl down, drag the object to the object at the same level in the tree
structure after which you want to place the copy.

3. When the icon is positioned in a valid location, release the mouse button.

Note: If you try to drop the icon in a position that is not valid, a red X appears
on the icon.

Expanding and collapsing the tree structure
You can collapse lower-level objects in the tree structure by following these steps:
1. Select the object in the tree structure that you want to collapse.
2. Press the minus (-) key.

3. The lower-level objects under the selected object are hidden and a + is added
to the right of the object in the tree structure to indicate that lower-level objects
are collapsed underneath it.

You can expand the view of an object which has hidden lower-level objects by
doing one of these:

» Double click the object in the tree structure.
» Select the object in the tree structure and press plus (+).
» To expand all levels of an object, select the object and press asterisk (*).

To expand all objects in the tree structure, press Ctrl + Page Down. To collapse all
objects in the tree structure, press Ctrl + Page Up.
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Chapter 9. Troubleshooting

Use the information in this chapter to troubleshoot problems that you might
encounter using Infoprint Designer. Use this table to find the description of your
error situation:

Symptoms

See

* Resources, such as page segments and overlays, are not
found even when they are in the default Infoprint Designer
directories.

* A blank name is shown in the Library field on the
Libraries dialog.

* You receive messages like this: “Error: OVFD7570E
Library profile variable for 'overlay' not found in
Tibrary!”.

“Library profile must exist’]

on page 72|

You open an overlay, a layout, or a project and get messages
that AFP resources are not found.

“Missing resources on thel

PC” on page 72]

No fonts are shown in the Select font dialog.

“No fonts listed in Select font

dialog” on page 73]

* You get messages from PSF when printing on the iSeries
that one or more fonts are not found.

* You upload resources to the iSeries but cannot find them
on the iSeries.

“Missing resources on the

iSeries” on page 74

You receive an error stating that a record exceeds the page
boundary.

'Off the page' error when

uploading a project to the

iSeries” on page 74

An object extends outside the red overlay boundary.

“Object outside of overlay|

boundary when uploading an|

overlay to the iSeries” on|

page 75|

A hard reboot of the PC occurs when mapping data.

“A hard reboot of the PC|

occurs when mapping data’

on page 75|

* Program starts in demo mode.
* You cannot save your work.

“Program starts in demo|

mode” on page 75|

The proof page on a PC printer looks different than the
iSeries output.

“Proof page on PC printer]

looks different than iSeries|

output” on page 76|

* You cannot map a drive to the iSeries through Windows
Explorer.

* You get the error message Installation not possible.

“Problems mapping a drive|

with Windows Explorer on|

our iSeries” on page 76|

Hex data appears when pasting text into an overlay.

‘Pasting text into an overlay|

ields hex data” on page 76

Landscape overlay rotates to portrait when you start the
Layout Editor.

“Landscape overlay rotates|

to portrait when startind_7|
Layout Editor” on page 7

The PC copy of an iSeries spooled file does not format
correctly in the Data window.

“The PC copy of an iSeries|

spooled file does not formaf]

correctly in the Datal

window” on page 77|
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Symptoms See

You cannot print the output from your iSeries to a PCL "Problems printing to an|
printer. iSeries-attached PCL printer’]
on page 77|

No text displays when using an overlay created with the AFP |[‘Migrating existing overlays’|

Windows driver. on page 19|

Fonts on printed page appear different than on Designer ‘_‘Pro_blems printing to an|
screen iSeries-attached IPDS]|

printer” on page 77|

When printing from the iSeries, the job goes on HOLD.
Overlays or page segments are not being printed.

When the file is printed on the iSeries, some data is printed |[‘Data prints twice from|
twice iSeries” on page 78|

You get a “Licence not valid” error message.

““Licence not valid” error|
message” on page 78|

Library profile must exist

As described in [‘Understanding libraries and library profiles” on page 3] Infoprint
Designer stores all of the directories where it searches for resources in a library
profile file with an extension of LBP. Infoprint Designer expects to find a library
profile file (DEFAULT.LBP by default) in the C:\DESIGNER\USERISIS directory. If for
some reason this file is moved or missing, you will have problems like these:

No fonts shown in the Select font dialog

Resources, such as page segments and overlays, are not found even when they
are in the default Infoprint Designer directories

Blank name shown in the Library field on the Libraries dialog

Messages such as this: Error: OVFD7570E Library profile variable for
'overlay' not found in library!

To correct this problem, follow these steps:

1.
2.

3.

From the Edit menu, select Change Library....

Browse for the correct library profile file. This file is DEFAULT.LBP for outline fonts
and RASTER.LBP for raster fonts.

If you cannot find an .LBP file on your PC, you must reinstall Infoprint Designer.

The installation program builds a library profile suitable for the types of fonts you
install. To reinstall Infoprint Designer, see [“Installing Infoprint Designer on your|

PC” on page 9.

Missing resources on the PC

72

If you open an overlay, a layout, or a project and get messages that AFP resources
are not found, check these:

Ensure you have the correct library profile defined for this project. To see what
library profile is being used, from the File menu, select New project and
examine the contents of the Library profile field. If you are using outline fonts,
this file should be DEFAULT.LBP. If you are using raster fonts, this file should be
RASTER.LBP. If the library profile is incorrect, follow the steps in

Select Cancel to close the dialog without starting a new project. Ensure that the
settings you have for resource prefixes are correct. To check the settings, follow
these steps:
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Ensure that no projects are open.

From the Edit menu, select Preferences....

Select the iSeries page.

The resource types selected in the Prefix area begin with the specified prefix.
For example, if the S1-Segments is not selected for page segments in the
Prefix area, Infoprint Designer looks for a page segments without an S1 at

the start of its file name. Page segments with the S1 prefix in its flename are
not found.

5. To change the prefix setting, select or deselect the appropriate box.

Ensure that the correct path is specified for the missing resource type. From the
Defaults menu, select Libraries.... Select the page for the type of object that
was reported missing. Look at the directories in the Library Path area. If the
directory where the resource resides is not listed, do one of these:

— Move the resource:

1. Copy the resource from the directory where it resides into one of the
directories listed in the Library Path area.

2. If the resource in error is a page segment, refresh the page segment. To
refresh a page segment, right-click the red Not Found box in the
View/Edit window. On the Page segment properties dialog, select
Refresh.

3. If the resource in error is not a page segment; save, close, and open the
project to see if the error goes away.

— Add the directory where the missing resource resides to the Library Path
area, if possible. The entries in the library profile are limited to 1024
characters for each resource type. Therefore, you might not be able to add
another directory:

1. From the Defaults menu, select Libraries....

For Path, specify the directory where the missing resource resides.

Select Append.

Select OK on the Libraries dialog.

If the resource in error is a page segment, refresh the page segment. To
refresh a page segment, right-click the red Not Found box in the
View/Edit window. On the Page segment properties dialog, select
Refresh.

6. If the resource in error is not a page segment, save, close, and open the
project to see if the error goes away.

A wbdpE

arweDn

No fonts listed in Select font dialog

If you open the Select font dialog and there are no fonts listed, check these:

See [‘Library profile must exist” on page 72.|

If you installed Infoprint Designer in a directory other than the default (Designer),
check the length of the path name. The entries in the library profile are limited to
1024 characters for each resource type. Therefore, using a long path name
(\Program files\Infoprint Designer, for example) can cause the font
information to be lost with no message given. You must reinstall Infoprint
Designer to solve this problem. To install Infoprint Designer, see
|Infoprint Designer on your PC” on page 9.|

If you recently updated the Infoprint Designer font catalog from the Libraries
dialog, the catalog might have been corrupted. Follow these steps:

1. From the Defaults menu, select Libraries.
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2. Select the appropriate page, such as Coded font, and select Build Cat. to
rerun the build catalog operation.

» If you are running Infoprint Designer from a shared server installation (on a thin
client workstation), you might need to copy the font catalog information from the
\Userisis directory to your own copy of that directory. See [‘Installing Infoprint|
|Designer on your PC” on page 9| for instructions.

Missing resources on the iSeries

If you upload resources in an Infoprint Designer project, but cannot find the
resources in the iSeries library where you expected them to be saved, look for
messages in \Designer\Userisis\AS400.L0G on the PC.

If you get messages from PSF when printing on the iSeries that one or more fonts
are not found, try one of these

e Ensure that you have installed the AFP Font Collection libraries listed in
[“Verifying prerequisites” on page 7.

» Have Infoprint Designer upload all of the fonts used in your project to the iSeries
when your project is uploaded:

1. From the Edit menu, select Preferences....
2. On the Preferences dialog, select the iSeries page. Select Send fonts.

* Be sure that the library where Infoprint Designer places the fonts is in the search
path defined for PSF for OS/400.

'Off the page' error when uploading a project to the iSeries
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If you receive an error stating that a record exceeds the page boundary, do one of
these:

» See if the placement position for one or more printlines has moved from the left
edge of the View/Edit window. To do this, follow these steps:

1. Right-click a field and look for a small blue anchor symbol along the left edge
of the View/Edit window. This anchor symbol shows the placement of the
record mapping called the printline. If you accidentally dragged the anchor
symbol while mapping data, the placement of all of the fields of data mapped
on this printline was adjusted accordingly. This might cause data to fall
outside the page boundary on some page in the spooled file, not necessarily
the one you are viewing.

2. Repeat step With each of the mapped fields.

3. If you find an anchor symbol that is not placed at the left edge of the page,
select it and drag it as close to the left edge as you can.
You might need to adjust the placement of the mappings from that record in
the View/Edit window.

4. From the File menu, select Upload to iSeries... to see if the error goes
away.

* Check the number of printlines in the Page definition tree window. Sometimes an
operation such as increasing the repeat count for a group of mapped records can
cause printlines to be added to the page format. This makes blank printlines
appear at the bottom of the page format, which causes data to be placed off the
page. To check the number of printlines, follow these steps:

1. From the Window menu, select Page definition.

Infoprint Designer for iSeries: Getting Started



2. Scroll down to the bottom of the current page format to find the last printline
(shown as [Rnn], where nn is the number of the printline). This number
should match the number of records you expect to print on a page, normally
66.

3. If there are more printlines than you expect, select the bottom printline and
then press Delete.

4. Repeat step E| until the number of printlines you see in the page format
matches the number of records per page in the spooled file.

Warning: Watch the results in the View/Edit window to be sure that you do
not delete printlines that map data on the page.
5. From the File menu, select Upload to iSeries... to see if the error goes
away.

Object outside of overlay boundary when uploading an overlay to the
ISeries

If an object extends outside the red overlay boundary, adjust its size to fit within the
overlay. From the View menu, select Fit in window so that you can see all of the
edges of the overlay. If you still do not see an object outside the overlay, follow
these steps:

1. From the View menu, select Fit in Window.

2. Right-click and drag a rectangle enclosing as much of the overlay as you can.
All of the objects in the overlay are shown with blue selection frames.

3. Look for empty blue selection boxes near the edges of the overlay. You might
need to zoom in to see them.

4. Delete any empty objects near the edge of the overlay.

A hard reboot of the PC occurs when mapping data

If a hard reboot of the PC occurs when you are mapping a field in layout design
mode, you might need to turn your video adapter accelerator down. To access your
video adapter accelerator settings, follow these steps:

1. Right-click an open area of your desktop.

2. In the menu that displays, select Properties.

3. Inthe Properties dialog, select the Settings page.

4. If a video adapter accelerator is present, lower it a notch or two.

Note: Not all video adapters have an accelerator that you can set.

Program starts in demo mode

If the connection between your workstation and the iSeries is interrupted while you
are working (including an abnormal termination of Infoprint Designer), Infoprint
Designer might start in demo mode when you restart the program. A message
saying that the license is in use by your userid is displayed. Because of the way the
iSeries session ended, the license you were using was not returned to its “not in
use” state. In demo mode, you cannot save your work or open overlay and layout
files that Infoprint Designer created.

In this case, wait approximately ten minutes before trying to start Infoprint Designer
again. By then, the license that was in use expires and you can use the program in
full-function mode again.
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Another problem that can cause the program to start in demo mode involves
permissions on a directory on the iSeries. The public authority to
\QIBM\ProdData\AFPDesigner\session must be *RWX. This authority is set by the
Infoprint Designer installation program and should not be changed.

If you saved your ID and password so that Infoprint Designer automatically logs you
on, and your iSeries password changes, the program will start in demo mode. To
change the password that Infoprint Designer uses to log you on to the iSeries,
follow these steps:

1. With Infoprint Designer started in demo mode, open the Edit menu and select

Preferences....
2. On the iSeries page, specify your new password.
3. Select OK.

Proof page on

PC printer looks different than iSeries output

The proof print process using your PC printer captures the contents of the
View/Edit window and creates a bitmap at the resolution of your PC printer. This
process is entirely different from the process used when printing with AFP resources
created by Infoprint Designer on an iSeries AFP printer. Differences in printer
resolution and data stream can cause the output of the two print operations to vary.

Note: Because the proof print function sends the contents of the View/Edit window
to the printer, you will normally see all of the overlays and layout data in the
project in a proof print. To print only the layout data, in the Window menu,
deselect Merge windows.

Problems mapping a drive with Windows Explorer on your iSeries

Before installing Infoprint Designer, you might discover that you cannot map a drive
through Windows Explorer. If this happens, contact your iSeries system
administrator to ensure that your iSeries is running NetServer, which is included as
part of your iSeries operating system.

If the installation program issues this message:

Installation not possible

Ensure that the drive you have mapped to your iSeries is at a level in the directory
structure higher than \\server-name\QIBM\ProdData\AFPDesigner. Although it
depends on how you have set up file sharing in your iSeries integrated file system,
the drive should be mapped to \\server-name\QIBM.

Pasting text into an overlay yields hex data

If you have copied text onto the clipboard and want to paste it into a text object on
an overlay, you must have the blinking I-beam cursor reflecting that you are in text
entry mode in the Overlay Editor when you select Paste. If you select Paste when
you are not in text entry mode, the text data in hexadecimal form is placed on the
overlay.
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Landscape overlay rotates to portrait when starting Layout Editor

If you designed an overlay in landscape presentation and then switch to the Layout
Editor to map data, the contents of the View/Edit window might be rotated to
portrait presentation. To set the presentation of the layout to landscape,

1. from the Edit menu, select Page properties....
2. On the Sizeffirst linepage, for Direction, select Down.
3. Select OK. The View/Edit window is rotated to landscape presentation.

To avoid this situation for future layouts, on the Layout properties dialog, select
Landscape when creating a new layout.

The PC copy of an iSeries spooled file does not format correctly in the

Data window

When you download a spooled file from your iSeries, a copy of it is saved on the
PC so that Infoprint Designer can reopen the data file anytime you work with the
project that uses that data. The spooled file attributes, such as the host code page
and record format, are saved in an .INF file with the same name as the name you
provided for the PC copy of the data file.

On the Layout Editor’s File menu, if you use the Get sample data function to open
the PC copy of the file, the values from the .INF file are shown in the Line data
options dialog. If you change these values, for example, changing code page 37
for EBCDIC data to the ASCII code page 437 or entering a different record length
than the original file had, Infoprint Designer might not display the data correctly in
the Data window.

To solve the problem without changing anything in the project, use Notepad to open
the .INF file with the same name as the data file in the Designer\data directory.
Make sure the values on the Line data options dialog match the values included in
the .INF file. If they are not the same, change the values on the Line data options
dialog. Do not change the .INF file.

Problems printing to an iSeries-attached PCL printer

If you cannot print the output from Infoprint Designer on a PCL printer, check the
version of your operating system and the applied PTFs.

» Printing output formatted with form definitions and page definitions created by
Infoprint Designer on a PCL printer is not supported on OS/400 V4R5.

* On 0OS/400 V5R1, PCL printing of Infoprint Designer layouts requires installation
of PTF S102688.

* Ensure that Convert line data(*YES) is specified on the printer file being used.
For more information, see step E| in IChapter 6, “Using your AFP resources with|
|your iSeries application,” on page 55.

Problems printing to an iSeries-attached IPDS printer

When printing your job that uses resources created with Infoprint Designer these
are some common problems you might have:

* Fonts on printed page appear different than on Designer screen
* When printing from the iSeries, the job goes on HOLD.
* Overlays or page segments are not being printed.
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If you have one of the above problems, try these solutions:

* On the iSeries, use the command DSPMSG QSYSOPR to check for font
substitution or “resource not found” messages. If there are such messages, make
sure that the fonts (character sets and code pages), page segments, and
overlays that were sent up from Designer are in a library that is in the library list
at the time the job is run.

» If the font library used for the Designer project is RASTER.LBP, check to see if
the resolution of the font (240 or 300-pel) matches the resolution of the printer
being used. To check the font resolution, use the WRKFNTRSC command.

 If the font library used for the Designer project is DEFAULT, check to see if the
printer being used supports downloaded outline fonts.

If you have with data printing twice, see [‘Data prints twice from iSeries.'1

| Data prints twice from iSeries

If you see the same print data twice on output from the iSeries that was formatted
using a layout built by Infoprint Designer, it is likely that the default suppression built
by Infoprint Designer got deleted. Infoprint Designer builds this default suppression
when you start the layout. It is initially set up to suppress printing of all data. This
way, only the fields that you map into the View/Edit window print. Any data in the
spooled file that you leave unmapped is suppressed. If the suppression is deleted
from the form definition, the iSeries will use its defaults to print data that you did not
map in Infoprint Designer. This could cause the data to appear twice; once by
default and the second time as you mapped it. Restoring the DFLT suppression
should resolve this problem.

To restore the suppression, follow these steps:
1. From the Window menu, select Form definition and right click the subgroup.

2. On the Edit subgroup dialog, enter DFLT in the Suppression area and select
Define. DFLT moves into the list beneath the entry field.

3. Select OK.

“Licence not valid” error message
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When you are not in demo mode, Infoprint Designer checks for a license on the
iSeries server every 10 minutes. If it cannot connect to the iSeries, you will get a
“Licence not valid” error message. There are several situations that can cause this
error to appear. If you get this message, check these:

* Make sure your FTP server is started. To check this, on the iSeries look for jobs
gtftp* in SBS QSYSWRK. If the server is not started, enter STRTCPSVR *FTP.

* Make sure the IP address specified for your FTP server is correct.

* The public authority to \QIBM\ProdData\AFPDesigner\session must be *RWX.

This authority is set by the Infoprint Designer installation program and should not
be changed.

» If your iSeries password changed, follow the steps in|“Program starts in demo|
|mode" on page 75| to change the password that Infoprint Designer uses to log
you on to the iSeries.
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Appendix A. Infoprint Designer sample projects

Table 3. Sample projects supplied with Infoprint Designer

Project Description Form definition Page definition

features features

BASIC Basic data layout with | Single copy Mapping most but not
invoice overlay; all fields. Changes in
simplex position and fonts

from SCS printing

TWOCPY Two copies of each Subgroups to select | Field mapping and
page (Invoice and input bins and suppression of prices
Packing slip) overlay and to select |for packing slip.

suppression of prices
on packing slip

BACK1 Like BASIC with Constant back Field mapping
Terms and Conditions | (overlay prints with
page on back no application data)

BACK2 Like TWOCPY with Subgroups and Field mapping and
Terms and Conditions | constant back suppression of prices
on back of Invoice for packing slip.
and a blank back on
the packing slip

COND Like TWOCPY with Subgroups to select | Different page format
conditional input bins and used for Total page
processing based on |overlay and to select |versus Continuation
“Continued”. suppression of prices |pages based on

on packing slip. conditional
processing.

COMBO Subgroups, constant | Subgroups and Different page format
back, and conditional |constant back used for Total page
processing. versus Continuation

pages based on
conditional
processing.

COR Landscape project to |Overlay used is Print direction DOWN
simulate computer rotated 90° specified in page
output reduction format.

(COR) function on
iSeries.

SEEDS Multiple-up layout for |Landscape Manual duplication
a label application. orientation and repositioning of

printlines.

Note: IBM @server iSeries Printing VI: Delivering the Output of e-business
provides detailed descriptions of how each of the sample projects was

created.
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Appendix B. Additional Font Information

Adding fonts

If you have fonts in AFP format on your PC that you want to use with Infoprint
Designer, you must update the font catalog to reference them. You need to know if
the fonts you are adding are in raster or outline format. If they are raster fonts, you
need to know their resolution (240 or 300 dpi). IBM recommends that you keep
these fonts in a separate directory from the AFP Font Collection that is installed
with Infoprint Designer. The default directories used by Designer are
\Designer\fonts\raster for raster fonts and \Designer\fonts\outline for outline
fonts.

Follow these steps to add the fonts to Infoprint Designer’s font catalog:
1. Start Infoprint Designer and do not open a project.

2. In the Overlay Editor, from the Edit menu select Change library. If you are
adding raster fonts, Select \Designer\userisis\RASTER.LBP as your library
profile. If you are adding outline fonts, select \Designer\userisis\DEFAULT.LBP
as your library profile.

3. From the Defaults menu select Libraries. A dialog like this opens:

Library: BASTER

Overlay
Coded Font
~Library Path _Character Set
Path Extension Code Page

CADESIGNERAFONTSA\RASTER. <>

Page Segment

TIFF

Append | Insert Delete | Change |

Search Build Cat. |

— T .

240 dpi 300 dpi 600 dpi

1] 4 Cancel | Help |

Figure 33. Libraries dialog
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4. Select the Coded font tab on the right side. If you are using raster fonts,
select the proper dpi tab from the bottom of the dialog. For example, 300 dpi.
The selected tab is gray.

5. Enter the directory in which the fonts are stored in the Path field. For example,
c:\Designer\myfonts. Select Append. The path appears in the list of paths.

6. Select the Character set tab on the right side of the dialog. If you are using
raster fonts, make sure the appropriate dpi tab stays selected on the bottom of
the dialog.

7. In the Path field, enter the same directory you specified in step B and select
Append. The path appears in the list of paths.

8. Select OK.

9. Messages are issued that say the Font catalog is being built, with filenames
flashing by. Depending on the speed of your PC, this might take a while.

10. When the font catalog build has completed, test to see if the fonts are
accessible to Infoprint Designer. To do this, select the Text icon from the
toolbar. Click in the View/Edit window. The Select Font dialog opens. Scroll
the list of Typefaces to find your new fonts.

Note: The entries Typefaces list are retrieved from a description field in the
font file. If your AFP font provider did not supply meaningful text in this
description field, you might see a dot or a line as an entry for your new
font.

Using MICR fonts with Infoprint Designer

IBM provides three MICR fonts in AFP format that are installed with the MICR font
option by the Infoprint Designer installation program. The installation program builds
references to these fonts into the Infoprint Designer font catalogs, so you can select
them from the font list. All of these MICR fonts are 300 dpi raster fonts that were
developed for use with the IBM 4028 printer and have not been verified to print
acceptably on any other IBM printers or printers from other manufacturers. IBM
does not claim that the use of these MICR fonts on any printer meets the
requirements of check-processing equipment.

Two of the MICR fonts provided are only accepted by AFP printers that identify
themselves as MICR-capable printers to PSF for OS/400. If your AFP printer rejects
these fonts, contact the vendor providing your MICR capability. If you choose to
print your MICR application on a PCL printer using Host Print Transform?, these
fonts work, but the guarantees provided by AFP for secure MICR printing are not
enforced.

The third MICR font is accepted by all printers, but prints with hollow characters.
This lets you develop the overlays and layout to test your MICR application even if
a MICR printer is not available.

ITabIe 4 on page 83| summarizes the font files provided as unsupported MICR
samples.

1. In VAR5, Host Print Transform does not support PCL printing using page definitions and form definitions created by Infoprint
Designer. In V5R1, PCL printing requires installation of PTF 2102688. V5R2 does not require any PTFs.
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Table 4. Font files provided as unsupported MICR samples

File name Contents

COROAE13.300 E13B character set; true MICR font

COROAT13.300 E13B character set; MICR test font; hollow characters
COROACMC.300 CMC-7 character set; true MICR font

T1001032 E13B code page

T1001033 CMC-7 code page

X0AE13 Coded font for COROAE13 and 71001032

XO0AT13 Coded font for COROAT13 and T1001032

X0ACMC Coded font for COROACMC and T1001033

If you have any other AFP MICR fonts on your PC that you want to use with
Infoprint Designer, use the procedure described in[‘Adding fonts” on page 81|to
define the fonts to Infoprint Designer.

Font file naming conventions

AFP applications on the iSeries commonly use 8-character names for coded font
files, such as XON210BC. Infoprint Designer uses 6-character names for coded font
files, and truncates the X0 (raster) or XZ (outline) prefix, showing only the final four
characters of the font name in, for example, the toolbar of the Overlay Editor.
Because of this and other cases where the 8-character font names could not readily
be truncated to four characters, the Expanded Core fonts in the AFP Collection are
provided in both naming schemes: 8-character names and 6-character names.
Infoprint Designer installs only the fonts with the 6-character names.

To ensure that you have this same set of fonts installed on your iSeries, ensure that
the libraries named CF4LAL (raster) and CO4LAL (outline) are restored from the
AFP Font Collection. Instructions to do this are available on the iSeries (AS/400)
AFP Font Collection Tools Support and Maintenance Web page at
lhttp://www.ibm.com/printers/R5PSC.NSF/web/rdfont01}

Use|[Table 5 on page 84|to help you decode the 4-character font names used by
Infoprint Designer. Assume that the 4-character name (for example, HOFT) has the
form RSTP, where

R Type family

S Style and weight

T Code page, combined with style and weight
P Point size

With [Table 5 on page 84} you can see that the HOFT font is a Roman-Bold
Helvetica font using the International #5 code page in 30-point.
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Table 5. Decoding 4-character font names used by Infoprint Designer

Letter Category Possible Values

Helvetica

Times New Roman
Courier

Letter Gothic
Gothic Text
Prestige

Boldface

R Type Family

oO|lo~No U A~NZT

S Style and Weight

(o8]

Values assigned randomly for Roman medium, Roman bold, Italic
medium, and Italic bold.

T Code page
(combined with
style and weight)

International #5 code page with Roman medium
International #5 code page with Roman bold
International #5 code page with Italic medium
International #5 code page with Italic bold

Euro code page with Roman medium

Euro code page with Roman bold

Euro code page with Italic medium

Euro code page with Italic bold

sc<womToU

P Point size Typographic fonts: Uniformly spaced fonts:

6 points 5 points (24 pitch)
7 points 6 points (20 pitch)
8 points 7 points (17.1 pitch)
9 points 8 points (15 pitch)
10 points 9 points (13.3 pitch)
11 points 10 points (12 pitch)
12 points 12 points (10 pitch)
13 points 14 points (8.5 pitch)
14 points 20 points (6 pitch)
15 points
16 points
17 points
18 points
19 points
20 points
21 points
22 points
23 points
24 points
25 points
26 points
27 points
28 points
29 points
30 points
31 points
32 points
33 points
34 points
35 points
36 points

COmO ©o~NOo U

N<Xs<CH0OTOTVTOZZIMrXACTIOMMOO®T>»O 00N

For a complete table mapping 6-character font names to 4-character font names,
refer to A Guide to Understanding AFP Fonts at
[http://publib.boulder.ibm.com/prsys/pdfs/Guide-to-fonts.pdf}
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Appendix C. Using the IPDATA Sample Application

As described in|Chapter 6, “Using your AFP resources with your iSeries]
fapplication,” on page 55 after your AFP resources have been uploaded to the
iSeries, you must change the printer file and run the application again to see the
results. The IPDATA sample application facilitates these steps for any project built
with the data from the invoicing program referenced in the examples in this book. If
you do not have the IPDATA sample application installed on your iSeries, follow
steps EI and E| in ['Installing Infoprint Designer on your iSeries” on page 8.|

The IPDATA sample application can be run in two modes:
» Creating the sample spooled file

* Applying the project’s page definition and form definition. This involves re-running
the sample application.

IPDATA includes the INV command that runs the application in both modes.

Creating a sample spooled file:

1. After the IPDATA library is installed, from an iSeries command interface, enter
Edit Library List (EDTLIBL) or Add Library List Entry (ADDLIBLE) command to
add IPDATA to your library list.

2. Enter INV and press F4. You can change any of the parameters except the
page definition and form definition parameters. The Size of file parameter lets
you create a small sample file (6 pages) or a large sample file (117 pages).

3. Enter Work with All Spooled Files (WRKSPLF) to verify that the INVSCS
spooled file has been created. It is created on your default output queue.

Running the sample application with your new design:

1. Save your Infoprint Designer project. From the File menu, select Upload to
iSeries... to compile and transfer all of the new print resources.

2. On the iSeries, ensure that the libraries you need (including the font libraries)
are in your library list. You can use Edit Library List (EDTLIBL) to do this.

3. Enter INV and press F4. Fill in any values you want, be sure to specify the page
definition and form definition names. The form definition and page definition
names are the same as the layout file’s name.

4. The INV command automatically takes care of the other printer file changes. In
this mode, the INV command overrides the printer file for the sample invoicing
application (printer file INVSCS) and runs the application program.

5. Use Work with All Spooled Files (WRKSPLF) or Operations Navigator to verify
that the new INVSCS spooled file has been created. On the Work with All
Spooled Files screen, the new spooled file has an asterisk next to the number
of pages indicating that it is an AFP spooled file.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information about the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property rights may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you any
license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785 U.S.A.

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply to
you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements and/or
changes in the product(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
Web sites. The materials at those Web sites are not part of the materials for this
IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3—chome, Minato-ku
Tokyo 106, Japan

Licensees of this program who wish to have information about it for the purpose of
enabling: (i) the exchange of information between independently created programs
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and other programs (including this one) and (ii) the mutual use of the information
which has been exchanged, should contact:

IBM Printing Systems Division
Department H7FE Building 003G
Information Development

PO Box 1900

Boulder CO 80301-9191 USA

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee. The licensed program described in this
document and all licensed material available for it are provided by IBM under terms
of the IBM Customer Agreement, IBM International Program License Agreement or
any equivalent agreement between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those
products, their published announcements or other publicly available sources. IBM
has not tested those products and cannot confirm the accuracy of performance,
compatibility or any other claims related to non-IBM products. Questions on the
capabilities of non-IBM products should be addressed to the suppliers of those
products.

All statements regarding IBM'’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

If you are viewing this information softcopy, the photographs and color illustrations
may not appear.

For online versions of this book, we authorize you to:

» Copy, modify, and print the documentation contained on the media, for use within
your enterprise, provided you reproduce the copyright notice, all warning
statements, and other required statements on each copy or partial copy.

» Transfer the original unaltered copy of the documentation when you transfer the
related IBM product (which may be either machines you own, or programs, if the
program’s license terms permit a transfer). You must, at the same time, destroy
all other copies of the documentation.

You are responsible for payment of any taxes, including personal property taxes,
resulting from this authorization.

Your failure to comply with the terms above terminates this authorization. Upon
termination, you must destroy your machine readable documentation.
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Trademarks

These trademarks and registered trademarks of the IBM Corporation are used in
this publication:

Advanced Function Presentation IPDS

AFP iSeries

AIX Mixed Object Document Content Architecture
AS/400 MO:DCA

Bar Code Object Content Architecture 0S/400

BCOCA Print Services Facility

IBM Redbooks

Infoprint z/0S

Intelligent Printer Data Stream

The following terms appear in this publication and are trademarks of other

companies: Intel Pentium

 Microsoft®, Windows, and Windows NT are registered trademarks of Microsoft
Corporation.

* Pentium is a registered trademark of Intel in the United States, other countries, or
both..

» Java is a trademarks of Sun Microsystems, Inc. in the United States, other
countries, or both.

Other company, product, and service names might be trademarks or service marks
of others.

EuroReady

Infoprint Designer is capable of processing data containing the euro sign. Font
character sets and code pages that contain and map the euro sign consistently with
the application must be present either in a host library or in the printer. AFP fonts
that support the euro sign are included in the AFP Font Collection for OS/400 that
ships with Program Number 5648-B45 and 5722-SS1.
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Glossary

This glossary defines technical terms and
abbreviations that are used in this documentation.
If you do not find the term you are looking for,
refer to the index of this publication or view IBM
Dictionary of Computing, located at:
lhttp://www.ibm.com/networking/nsg/nsgmain.htn

Definitions reprinted from the American National
Dictionary for Information Processing Systems are
identified by the symbol (A) following the
definition.

Definitions reprinted from a published section of
the International Organization for Standardization
(ISO) Vocabulary—Information Processing or from
a published section of Vocabulary—Office
Machines developed by Subcommittee 1, Joint
Technical Committee 1, of the International
Organization for Standardization and the
International Electrotechnical Committee (ISO/IEC
JTC1/SC1) are identified by the symbol (1)
following the definition. Because many 1ISO
definitions are also reproduced in the American
National Dictionary for Information Processing
Systems, ISO definitions might also be identified
by the symbol (A).

Definitions that are specific to IBM products are so
labeled—for example, “In SNA,” or “In the 3820
printer.”

These cross-references are used in this glossary:

e Contrast with. Refers to a term that has an
opposite or substantively different meaning.

* See. Refers to multiple-word terms in which this
term appears.

* See also. Refers to related terms that have
similar, but not synonymous, meanings.

* Synonymous with. Appears in the commentary
of a preferred term and identifies less desirable
or less specific terms that have the same
meaning.

A

Advanced Function Presentation™ (AFP). A set of
licensed programs, together with user applications, that
use the all-points-addressable concept to print on
presentation devices. AFP includes creating, formatting,
archiving, retrieving, viewing, distributing, and printing
information. See |presentation devicel
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AFP. See |Advanced Function Presentation.|

AFP data stream. A presentation data stream that is
processed in the AFP environment. MO:DCA-P is the
strategic AFP interchange data stream. IPDS™ is the
strategic AFP printer data stream.

AFP Viewer. (1) Refers to the AFP Workbench Viewer
and the AFP Viewer Plug-in. A Windows IBM-licensed
PC product that lets you see AFP output in a WYSIWYP
(what-you-see-is-what-you-print) format. (2) A Windows
platform for the integration of AFP-enabling applications
and services.

AFPDS. A term formerly used to identify the composed
page; MO:DCA-P-based data stream that is
interchanged in AFP environments.

architecture. The set of rules and conventions that

govern the creation and control of data types such as
text, image, graphics, font, fax, color, audio, bar code,
and multimedia.

ASCII.  American National Standard Code for
Information Interchange data encoding, which is the
normal (default) type of data encoding in an AIX®
environment. Contrast with

B

Bar Code Object Content Architecture™ (BCOCA™).
An architected collection of control structures used to
interchange and present bar code data.

BCOCA. See Bar Code Object Content Architecture]

bin. A paper supply on a cut-sheet printer. See also

[cassette]
bitmap font. See|[raster fonf

C

carriage control character. An optional character in
an input data record that specifies a write, space, or
skip operation.

cassette. In a cut-sheet printer, a movable enclosure
for paper supply. See also

ccsid. Seelcoded character set identifier.|

character. (1) A symbol used in printing. For example,
a letter of the alphabet, a numeral, a punctuation mark,
or any other symbol that represents information. (2) A
byte of data.
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channel code. A number from 1 to 12 that identifies a
position in the page definition. A carriage control
character can select a position defined by a particular
channel code.

character set. (1) A finite set of characters upon which
agreement has been reached and that is considered
complete for some purpose; for example, each of the
characters in ISO Recommendation R646 “6- and 7-bit
coded character sets for information processing
interchange.” (2) For page printers, the font library
member that contains the character graphics and their
descriptions.

coded character set identifier. The ID associated

with a code page.

coded font. A font library member that associates a
code page and a font character set. For double-byte

fonts, a coded font associates more than one pair of

code pages and font character sets.

code page. A font component that associates code
points with character identifiers. A code page also
identifies how undefined code points are handled.

code point. A one-byte code representing one of 256
potential characters.

concatenate. (1) To link together. (2) To join two
character strings.

concatenated data set. In iSeries, a group of logically
connected data sets that are treated as a single data
set for the duration of a job step. See also
continuous forms paper. A series of connected forms
that feed continuously through a printing device. The
connection between the forms is perforated to enable a
user to tear them apart. Before printing, the forms are
stacked, folded along the perforations. Contrast with

sheet paper

control character. A character that starts, changes, or
stops any operation that affects recording, processing,
transmitting, or interpreting data (such as carriage
return, font change, and end of transmission).

cut sheet paper. Paper that is cut into separate

sheets before it is printed on. Contrast with [continuous]|

D

data set. A named set of records that are stored and
processed as a unit. Synonym for file.

data stream. (1) All information (data and control
commands) sent over a data link, usually in a single
read or write operation. (2) A continuous stream of data
elements being transmitted, or intended for
transmission, in character or binary-digit form, using a
defined format.

92  Infoprint Designer for iSeries: Getting Started

default. An attribute, value, or option that is assumed
when none is explicitly specified. (1)

disabled mechanism. PSF support that enables jobs
to print with alternative options if the printer selected for
the job does not support a requested option. Contrast

with

document. (1) A publication or other written material
pertaining to a specific subject or related subjects. (2) In
word processing, a collection of one or more lines of
text that can be named and stored as a separate entity.

double-byte coded font. A font in which each
character is defined by two bytes. The first byte defines
a coded font section and the second defines a code
point in that section. Double-byte coded fonts are
needed for the support of languages that require more
than 256 graphic characters. Two bytes are required to
identify each graphic character. Kaniji is printed by using
a double-byte font. Contrast with [single-byte coded font]

download. To transfer data from a processing unit to
an attached device such as a microcomputer for
processing.

duplex printing. Printing on both sides of a sheet of
paper. Contrast with

EBCDIC. Extended binary-coded decimal interchange
code.

electronic form. See |overlay]
electronic overlay. See |overlay|

enabled. (1) Pertaining to a state of the processing
unit that allows certain types of interruption. (2) A
condition of the printer (physically selected) in which the
printer is available to the host processor for normal
work. Contrast with |disabled mechanism}

end-user interface. A method by which a customer
can obtain the services of a product, for example,
coding samples, commands and command lists. Not
every product has an end-user interface. Some products
provide their services through programming interfaces,
some provide services through a command line
interface, and others provide services only to other
products.

escape character. The control character X'2BD3' in a
text-control sequence that indicates the beginning of the
sequence and the end of any preceding text.

euro. The monetary unity of the European Monetary
Union (EMU), introduced alongside national currencies
on the first of January, 1999.

EuroReady product. A product is EuroReady if the
product, when used in accordance with its associated



documentation, is capable of correctly processing
monetary data in the euro denomination, respecting the
euro currency formatting conventions (including the euro
sign). This assumes that all other products (for example,
hardware, software, and firmware) that are used with
this product are also EuroReady. IBM hardware
products that are EuroReady might or might not have
an engraved euro sign key on their keyboards.

exception. A condition that exists when the printer:

» Detects an invalid or unsupported command, order,
control, or parameter value from the host

» Finds a condition of which the host system must be
notified

» Detects a condition that requires the host system to
resend data

execution. The process of carrying out an instruction
or instructions of a computer program by a computer. (I)

(A)

extended binary-coded decimal interchange code
(EBCDIC). A coded character set of 256 eight-bit
characters.

F

field. Individual pieces of data, such as a customer
name or address, that you map onto the page

font. A family or assortment of characters of a given
size and style; for example, 9-point Bodoni Modern.

(A)
font character set. Synonym for[character sef]

form. A division of the physical medium. Multiple forms
can exist on a physical medium. For example, a roll of
paper might be divided by a printer into rectangular
pieces of paper, each representing a form. An envelope
is an example of a physical medium that has only one
form. The IPDS architecture defines 4 types of form:
cut-sheets, continuous forms, envelopes, and computer
output on microfilm. Each type of form has a top edge,
a front side, and a back side. Synonymous with [sheef

format. (1) A specified arrangement of such things as
characters, fields, and lines, usually used for displays,
printouts, or files. (2) To arrange such things as
characters, fields, and lines. (3) To prepare a document
for printing in a specified format.

form definition. A resource that PSF uses to define
the characteristics of a form. It specifies overlays to be
used (if any), paper source (for cut-sheet printers),
duplex printing, text suppression, the position of
MO:DCA™ data on the form, and the number of copies
and modifications of a page.

G

GOCA. See [Graphic Object Content Architecture}

Graphic Object Content Architecture (GOCA). An
architecture that provides a collection of graphics values
and control structures used to interchange and present
graphics data.

GIF. See [graphical image format|

graphical image format (GIF). A digital format that is
used to compress and transfer graphical information
over computer networks. For example, GIF is a
common format for graphical information on the Internet.

H

hardcopy. (1) A copy of a display image that is
generated on an output device such as a printer and
can be carried away. (T) (2) A printed copy of machine
output in a visually readable form, for example, printed
reports, listings, documents, and summaries.

hexadecimal. Pertaining to a numbering system with
base of 16. Valid numbers use the digits 0 through 9
and characters A through F, where A represents 10 and
F represents 15.

host font. See .

host processor. The processing unit to which the
page printers are attached through a data-transfer
interface.

host resource. A resource found in a system library,
in a user library, or inline in the print data set.

host system. (1) A data processing system that
prepares programs and operating environments for
another computer or controller. (2) The data processing
system to which a network is connected and with which
the system can communicate.

image. A pattern of toned and untoned pels that form
a picture.

image data. A pattern of bits, with values of 0 and 1,
that defines the pels in an image. (A 1-bit is a toned

pel.)

Image Object Content Architecture (IOCA). An
architected collection of constructs used to interchange
and present images.

IOCA. Seelimage Object Content Architecturel

initialize. (1) In programming languages, to give a
value to a data object at the beginning of its lifetime.
() (2) To set counters, switches, addresses, or the
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contents of storage to zero or other starting values at
the beginning of, or at prescribed points in the operation
of, a computer routine. (A)  (3) To prepare for use. For
example, to initialize a diskette.

inline. The direction of successive characters in a line

of text. Synonymous with

inline direction. The direction of successive
characters in a line of text.

inline resource. A resource contained in the print data
set.

input/output (1/0). Pertaining to a device whose parts
can perform an input process and an output process at
the same time. (I)

Intelligent Printer Data Stream™ (IPDS). (1) The data
stream generated by PSF to send to an IPDS page
printer. (2) An all-points-addressable data stream that
enables users to position text, images, and graphics at
any defined point on a printed page.

interface. A shared boundary. An interface can be a
hardware component used to link two devices. It can
also be a portion of storage or registers accessed by
two or more computer programs.

I/O. Input/output.

IPDS. See|intelligent Printer Data Stream |

iSeries Information Center. A Web site that contains
technical information about the iSeries, including
instructions for completing tasks and informational
topics. You can access the version of the Information
Center corresponding to the version of the OS/400
operating system you have installed. To access the
Information Center, go to

[http://www.ibm.com/servers/eserver/iseries/infocenter}

J

JPEG. Joint Photographic Experts Group. A standard
format for storing compressed true-color images.

Joint Photographic Expert Group (JPEG). The name
of the committee that developed the JPEG standard
format.

L

library. A file or a set of related files, for example, a
page definition library containing one or more page
definition files.

licensed program. A utility that performs a function for
the user and usually interacts with and relies upon
system control programming or some other
IBM-provided control program. A licensed program
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contains logic related to the user’s data and is usable or
adaptable to meet specific requirements.

line data. Data prepared for printing on a line printer
such as an IBM 3800 Printing Subsystem Model 1. Line
data is usually characterized by carriage control
characters and table reference characters. Contrast with

line printer. A device that prints a line of characters as

a unit. () (A) Contrast with

logical page. A presentation space. One or more
object areas or data blocks can be mapped to a logical
page. A logical page is rectangular and has specifiable
characteristics such as size, shape, orientation, and
offset. Orientation and offset are specified relative to a
coordinate system for the medium.

logical page origin. (1) The point on the logical page
from which the positions of images, graphics, page
overlays, and text with 0-degree inline direction are
measured. (2) The point on the logical page
represented by Xp=0, Yp=0 in the Xp coordinate
system.

M

medium overlay. An electronic overlay that is invoked
by a form definition for printing at a fixed position on the
form. See also

Microfilm device. An output device that presents a
hardcopy on microfilm.

migration. Activities that relate to the installation of a
new version or release of a program to replace an
earlier level. Completion of these activities ensures that
the applications and resources on your system will
function correctly at the new level.

Mixed Object Document Content Architecture™. A
strategic, architected, device-independent data stream
used for interchanging documents.

MO:DCA. See |Mixed Object Document Contentf

|Architecture.|

MO:DCA data. Print data that has been composed
into pages. Text-formatting programs such as DCF can
produce composed text data that consists entirely of
structured fields.

MO:DCA data page. A page of print data that consists
entirely of structured fields.

MO:DCA print data set. A print data set that consists
entirely of structured fields.

MO:DCA-P. Mixed Object Document Content
Architecture for Presentation.
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multiple-up printing. Printing more than one page of
application data on a single surface of a sheet of paper.
Multiple-up printing is specified in the page definition.

N

N-up printing. Dividing a side of a sheet into a fixed
number of equal-size partitions. N-up printing is
specified in the form definition.

nested resource. A resource mapped in an overlay.

non-square pixels. An image that has different
resolutions in the X (horizontal) and Y (vertical)
directions is said to have non-square pixels.

O

outline font. A font technology in which the graphic
character shapes are represented by a series of
mathematical expressions that define the outer edges of
the strokes. The resulting graphic character shapes can
be either solid or hollow. Outline fonts can be scaled
(sized) to any size. The IBM outline font character sets
have a prefix of CZ. Contrast with

overlay. A collection of constant data, such as lines,
shading, text, boxes, or logos, that is electronically
composed in the host processor and stored in a library.

It can be merged with variable data during printing.
Contrast with page segment

page. A collection of data that can be printed on a
physical sheet of paper.

page format. A subset of a page definition, containing
controls that govern the arrangement of text on a page.

page overlay. An electronic overlay that can be
invoked for printing and positioned at any point on the

page in the print data. See also[medium overlay]

page printer. Any of a class of printers that accepts

MO:DCA-P pages. Contrast with

page segment. A resource containing MO:DCA data
and images, prepared before formatting and included as
part of the input for a print job.

parameter. (1) A variable that is given a constant
value for a specified application and that may denote
the application. (I) (A)  (2) An item in a menu for which
the user specifies a value or for which the system
provides a value when the menu is interpreted. (3) Data
passed between programs or procedures.

pel. See|picture element.

physical medium. A physical entity on which
information is presented. Examples of physical media
are display screens, paper, foils, microfilm, and labels.

picture element (pel). An element of a raster pattern
about which a toned area on the photoconductor might

appear. See also [raster pattern

pitch. A unit of measurement for the width of a printed
character, reflecting the number of times a graphic
character can be set in 1 linear inch. For example,
10-pitch has 10 graphic characters per inch. Contrast
with [point]

point. A unit of measurement about 1/72 of an inch. It
used to measure the height of a font. Contrast with

point size. The height of a font in points.

presentation device. A device that produces
character shapes, graphics pictures, images, or bar
code symbols on a physical medium. Examples of
physical media are display screens, paper, foils,
microfilm, and labels.

print job. The data that a user submits to PSF for
printing.

Print Services Facility (PSF). PSF is a licensed IBM
program that manages and controls the input data
stream and output data stream that required by
supported IBM page printers. PSF manages printer
resources such as fonts, images, overlays, form
definitions, and page definitions, and provides error
recovery for print jobs.

When printing line data, PSF supports external
formatting by using page definitions and form
definitions. This external formatting extends page printer
functions such as electronic forms and use of
typographic fonts without any change to applications
programs.

printable area. The area on a sheet of medium on
which print can be placed.

printer. A presentation device that produces hardcopy
output. See [presentation device}

processor. In a computer, a functional unit that
interprets and executes instructions. (1) (A)

PSF. See[Print Services Facility}

R

raster font. A font technology in which the graphic
characters are _defined directly by the raster bit map.
Contrast with joutline font

raster pattern. A series of picture elements (pels) in
scan lines to form an image. See also
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resolution. In computer graphics, a measure of the
sharpness of an image. It is expressed as the number
of lines and columns on the display screen or the
number of pels per unit of linear measure.

resource. (1) A collection of printing instructions that
are used by PSF in addition to the print data set to
produce printed output. PSF resources include coded
fonts, font character sets, code pages, page segments,
overlays, form definitions, and page definitions. (2) Any
source of aid that is used for performing a task, such as
disk storage space, computer processing time, and
communication lines.

resource name. The name under which a resource
object is stored, the first two characters of which
indicate the resource type:

X0-XG,XZ Coded font

T1 Code page

C0-CG,Cz Font character set

S1 Page segment

F1 Form definition

P1 Page definition

o1 Overlay

H1 Recommended for microfilm
rotation. The number of degrees a graphic character

is turned relative to the page coordinates.

segment. Synonym for [page segment]

sheet. A division of the physical medium on which
data is presented. The IPDS architecture defines 4
types of sheet: cut-sheet forms, continuous forms,
envelopes, and computer output on microfilm. Each
sheet has a front side and a back side. Some types of
media consist of multiple sheets; for example, a roll of
continuous forms can be divided at the perforations into
rectangular sheets. Each sheet usually has carrier or
tractor-feed strips, also. Microfilm is another example of
a medium comprising multiple sheets, whereas an
envelope has only one sheet. Synonymous with [forr]

simplex printing. Printing on one side of the paper.

Contrast with |[duplex printing

single-byte coded font. A font in which the characters
are defined by a one-byte code point. A single-byte
coded font contains only one coded font section.
Contrast with [double-byte coded font

spooled file. A file created by an application program
that contains the actual information to be printed. It also
contains some of the data that controls the format of the
printing.

structured field. A self-identifying, variable-length,
bounded record that can have a content portion that
provides control information, data, or both.
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subpage. A part of a logical page on which data can
be placed. In the page definition, multiple subpages can
be placed on a physical page as specified in the print
data.

syntax. The rules and keywords that govern the use of
a programming language.

T

table reference characters (TRC). An optional control
character in an input record that identifies the font with
which the record is to be printed. The table reference
character corresponds to a font number defined in a
page definition font list or to the order of font names
listed in the CHARS parameter in the JCL.

Tag Image File Format (TIFF). A graphic file format
used to store and exchange scanned images;
compatible with a number of personal computing
platforms.

terminate. (1) To stop the operation of a system or
device. (2) To stop execution of a program.

text. A graphic representation of information on an
output medium. Text can consist of alphanumeric
characters and symbols that are arranged in
paragraphs, tables, columns, or other shapes.

TIFF. See|[Tag Image File Formatl

token ring. A network configuration in which tokens
are passed in a circuit from node to node. A node that is
ready to send can capture the token and insert data for
transmission.

trace. A record of the execution of a computer
program. It exhibits the sequences in which the
instructions were executed. (A)

TRC. Seeltable reference character|

U

upload. (1) To transfer programs or data from a
connected device, typically a personal computer, to a
computer with greater resources. (T) (2) To transfer
data from a device, such as a workstation or a

microcomputer, to a computer. Contrast with

V

Viewer. See|AFP Workbench Viewer|

X

X-axis. In printing, an axis perpendicular to the
direction in which the paper moves through the printer.

See also




X-extent. A measurement along the X-axis.

Y

Y-axis. In printing, an axis parallel to the direction in
which the paper moves through the printer. See also

Y-extent. A measurement along the Y-axis.
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E
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examples
changing format based on trigger 48
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customization for when Infoprint Designer code
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F
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defined 65
file name rules 3
file names 2
fonts
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AFP Font Collection 8
Font Code Pages 9
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paths for AFP raster fonts 4
using MICR fonts 82
form definitions
functions 64
structure 66
format, example of changing 48
formatted text object, creating 21
formatting complex applications 40

G

grid, tips using 25
group design assistants 22

H

hard reboot of PC occurs when mapping data 75
hardware prerequisites 7
help available 5
hex data, not text from paste 76
hints and tips
Infoprint Image Editor 61
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Image Editor
hints and tips 61
starting 59
using 59
working with its window 59
image, adding to overlay 24
Infoprint Designer window
Overlay editor 14
title bar 14
View/Edit subwindow 14
Infoprint Designer, what can | do with it 1
installing Infoprint Designer 7
installing PTFs on Infoprint Designer 11
IPDATA sample application 85
iSeries Information Center Xii

K

keyboard accessibility 16

L

landscape orientation
specifying 34
landscape overlay rotates to portrait when starting
Layout Editor 77
Layout Editor 29
mapping application output to an overlay 37
mapping data to the layout 37
page breaks 40
migrating existing form definitions 64
migrating existing page definitions 64
migrating PPFA source files 64
selecting sample data from PC 31
selecting sample data from the iSeries 29
Layout Editor windows 35
layout wizard
described 40
examples of using 43
using 41
libraries
default paths for resources 4
understanding 3
library
lists 56
profile missing 72
profiles 4
license for Infoprint Designer 8
Line data options dialog 33
lines, creating 20
logical page 63

M

mapping a drive on iSeries, problems 76
mapping application output to an overlay 37
mapping data to the layout 37

page breaks 40
MICR fonts 82
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migrating existing overlay 19
migrating to Layout Editor
existing form definitions 64
existing page definitions 64
PPFA source files 64
missing resources on PC 72
multiple overlays in a project 27

N

new application in production 55
no fonts listed in Select font dialog 73
notices 87

O

object outside of overlay boundary when uploading
off the page error when uploading a project 74
operating system prerequisites 7
0S/400 command syntax Xi
Overlay Editor 19
tips and hints 25
overlay objects 20
overlay project 1
overlays 19
adding an image 24
bar code object 21
boxes 20
circles 20
creating overlay objects 20
designing 19
editing objects 21
lines 20
mapping output 37
multiple in a project 27
paths 20
printing 27
proof printing 25
saving 26
starting 19
text 21
uploading 26
overlays, example of changing 43, 48

P

page break 37
page breaks when mapping data 40
page definitions
functions 63
structure 64
page definitions and form definitions
functions
form definitions 64
page definitions 63
introduction 63
structure
form definitions 66
page definitions 64
page format
defined 64

75



page segment
adding an image to overlay 24
AFP image format 61
library profile 4
placing with data 63
resolution-dependent 13
path object, creating 20

PC copy of spooled file formatting incorrectly in Data

window 77
polyline object, creating 20
portrait orientation
specifying 34
PPFA source files
migrating to Layout Editor 64
restrictions when importing 64
preparations for installing Infoprint Designer 8
preprinted forms, replacing 19
prerequisites 7
hardware 7
operating system 7
software 7
printing overlays 27
printlines i
associating with channel codes 65
blank 74
deleting 75
described 65
determine the number of 74
duplicating 79
errors related to 74
grouping 40
move 17
moved 74
number per page 65
off the page error 74
properties 65
repositioning 79
spacing of 17
ungrouping 40
working with 68
problems printing to an iSeries-attached IPDS
printer 77
problems printing to an iSeries-attached PCL
printer 77
product description
about the Infoprint Designer license 8
components 1
hardware prerequisites 7
Image Editor 59
Infoprint Designer window 14
installing Infoprint Designer 7, 8, 9
installing PTFs on Infoprint Designer 11
introduction 1
IPDATA sample application 85
Layout Editor 29
operating system prerequisites 7
Overlay Editor 19
sample projects 79
software prerequisites 7
updating the Infoprint Designer program 11
program starts in demo mode 75

projects
creating based on another 26
sample 79
understanding 2
proof page on PC printer different 76
proof-printing overlays 25
PTFs required xiii
publications, related 99

R

related publications 99
reordering objects in the tree structure 68
repeat design assistants 22, 23
replacing preprinted forms 19
required PTFs  xiii
restrictions when importing

PPFA source files 64
right-click, tips 25
rotation, overlay 77
rotation, page segment 61
rotation, specifying for layout 34
rules for naming files 3

S

sample data, selecting from iSeries 29
sample data, selecting from PC 31
sample projects 79
saving a spooled file 29
saving your overlays 26
scenarios for using Infoprint Designer 1
selecting multiple objects 22
selecting sample data from iSeries 29
selecting sample data from PC 31
setting layout properties 33
shortcuts 16
software prerequisites 7
Software Support 5
specifying default units 14
starting an overlay project 19
starting Infoprint Designer 13
subpage, defined 65
support for Infoprint Designer for iSeries
defect reporting 5
how to support 5
usage support 5
suppressing data, example 43, 48
syntax notation  xi

T

text object, creating 21
tips and hints

Overlay Editor 25

shortcuts 16
toolbars 15

action 15

mode 15

working 15

Index
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tree windows
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deleting an object from the tree structure 68
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introduction 68
reordering objects in the tree structure 68
triggers 48
troubleshooting 72
“Licence not valid” error message 78
data prints twice from iSeries 78
hard reboot of PC occurs when mapping data 75
hex data, not text from paste 76
Installation not possible 76
landscape overlay rotates to portrait when starting
Layout Editor 77
Library profile must exist 72
mapping a drive on iSeries 76
missing resources on PC 72
no fonts listed in Select font dialog 73
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uploading 75
off the page error for project 74
PC copy of spooled file formatting incorrectly in Data
window 77
problems printing to an iSeries-attached IPDS
printer 77
problems printing to an iSeries-attached PCL
printer 77
program starts in demo mode 75
proof page on PC printer different 76

U

understanding
file names 2
libraries 3
projects 2
syntax notation xi
unformatted text object 21
unformatted text object, creating 21
uninstalling
Image Editor 11
Infoprint Designer 11
updating Infoprint Designer with PTFs 11
uploading overlays 26
using your Infoprint Designer Resources 55

W

what can | do with Infoprint Designer 1
Windows command syntax Xxi
wizard

See also layout wizard

using 40
working with multiple objects 22
working with tree windows 68
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